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Preface

|1 Preface

General remarks

These operating instructions are supplied with the unit.

They should be kept close at hand and remain with the equipment even if the
equipment is sold.

We reserve the right to make changes, on the basis of technical developments, to
the data and diagrams given in these operating instructions.

Reproduction, translations and duplications in any form, including extracts,
requires the written approval of the issuing company.

These operating instructions are not covered by any amendment service.

In each case, the latest information can be requested from a specialist dealer or
directly from

Westfalia Landtechnik GmbH
Werner Habig Str. 1

59302 Oelde

Tel. (02522) 77 0

Notes from the manufacturer to the user

Westfalia Landtechnik machines (equipment) incorporate state-of-the-art
technology, functions and effects in accordance with standard safety requirements
in EC directives.

Notes for the owner

Warranty

The owner is responsible for ensuring that all safety instructions are followed and
that this software is used in accordance with the intended purpose.

He must make sure that every user knows how to use the software/computer and
can operate them safely.

Only use computers which are in perfect working condition.

Technical terms, special names or sector-specific terminology that are used in these
operating instructions are explained in more detail in the glossary in the
“Appendix”.

The valid warranty is described in the delivery conditions.
The owner will not be entitled to make a claim under warranty if

e damage is caused as the result of a malfunction due to use which is not as
agreed or incorrect operation.

e repairs or actions are carried out by people who are neither authorised nor
trained to do so.

e accessories or spare parts are used which cause damage and have not been
released by Westfalia Landtechnik GmbH.

7160-90017-521
12-2002



DAIRYPLAN

Description
|12 Description
Operation in accordance with Operating Instructions
Lo 7160-90. . -520 DAIRYPLAN Operation

Correct applications

The operating instructions must also be observed to ensure correct application.

2.1  DAIRYPLAN

DAIRYPLAN is a herd management program for the comprehensive management,
analysis and monitoring of a herd from the point of view of:

e Income from milk
e Feeding
e Assessing
e Insemination / Pregnancy
For more detailed information, please see
(L7 7160-90. . -520 DAIRYPLAN Operation
DAIRYPLAN can be operated with one or more PCs (network)..

Structure of the program

DAIRYPLAN has a modular structure.
This means that the program can be expanded according to the farmer’s
requirements.

For example, if DIARYPLAN is to be expanded by a milk metering system the
corresponding option P-M will have to be added.

[]?> Note!

Each additional option requires a new software key. The costs of the new
options are calculated by the Technical Centre or the dealer if they have
not been obtained before.

Includes

Part No. Description

Electronic card test adapter for the Dual Port

7162-3047-080 Card/Multi-Port Card

The DAIRYPLAN CD ROM contains all languages, all
7162-2362-000 | modules, types of installation include new, demo, update,
upgrade

7160-9007-521
2 12-2002



DAIRYPLAN
Description

2.1.1 Networks

Design

In a network several computers are connected together. This means that all users
can work with one data source (databank).

In the centre there is the main computer (also called a server or master computer)
on which DAIRYPLAN is installed with the databank.

All of the other computers (also called slave computers, clients or work stations) use
DAIRYPLAN without it being installed on their own hard disks.

The size of the network depends upon the network software and the network
hardware used. There are networks on which between 2 and over 255 users or
computers can be connected.

Dividing Tasks among the Computers

DAIRYPLAN has network capability. This means that the DAIRYPLAN databank can
be accessed and edited from several computers at the same time, or in WINDOWS,
from different windows

A network with DAIRYPLAN generally consists of two to three computers. With
suitable network software, in theory, the number of computers can be increased
to several hundreds of stations.

Every DAIRYPLAN computer in a network is given a specific task (mode).
MASTER-Mode

The master or main computer is always the first computer in the network to
start. It supplies all automatic calculations, costings and reports and controls
the peripheral units.

When a DIARYPLAN version is started it always tries to take over the "master
function”. It succeeds in this unless DAIRYPLAN finds another version which
already has a “master function”.

SLAVE-Mode:

The slave computer has no control over peripheral units but is a complete input
or control point for herd management. The user has the facility at all times -
independently of any other computers in the network - to look at reports or
graphics, or, for example, to enter vet actions.

- Area of use (example)
The master computer with a peripheral connection is in the milking parlour
office. Another “slave” computer is installed in the home office so that herd
management jobs can be carried out in the evenings.

7160-90017-521
12-2002



DAIRYPLAN
Description

2.1.2 Structure of a DP installation

Surge voltage protection

Second computer with

network coupling

UPS unit or stabilizer (urgently UPS unit or stabilizer  SUrge V?/ tage
\ { recommended) | (possibility) -1 protectipn
\N L1/ AN 7 -
Main DAIRYPLAN L_Jd
Mains & iy computer ' A !
. . PC ) PC
Windows printer !
with graphics
LaPab":“_l'_t H
f— '
[::':] 0 001 O O713 013 ! D OO OO0 O11173 0O I
l______Jl
8 | |
| , |
max_3m /" T A T - - - -
Multi-Port Card T\ Free slots for other cards
(plug-in card)
CL transformer box
Cable 4x1 mm?2, |, = 500 m =
Cable 4x1 mm2, ., =10m  Cable 4x1 mmZ, | . = 10 m
1. 2. 3. further
Power Supply Power Supply Power Supply Power Supply
Cable 4x1 mm?2. lpay =50 m
— 1 I
FA FA FA FA FA FA FA = automatic feeder
max. 6 7162-3350-050
7160-90017-521
4

12-2002




DPNET interface
Description

|2.2  DPNET interface

The DPNET interface is used in installations which are based on modern Westfalia

network technology.

It is intended exclusively to create the data connection between the "DAIRYPLAN”
program and the Westfalia peripherals connected.

[]?> Note!

The DPNET interface is not designed for use in any types of application
other than the ones listed here!
This would be considered as use not in accordance with the intended

purpose!
Technical data
DPNET interface XLON PCI
Operating systems: Win 98SE | ME | 2000 | XP
Connection: PCI
Dimensions: 47cmx13.2cm(hx|)

CE:
- Interference immunity
- Emitted interference

EN50082-1 (IEC 801-2/801-3/801-4)

EN50081-1/EN55022

Includes
e DPNET interface
b
Part No. Description
7300-9047-110 | DPNET interface XLON PCI
e Driver software on diskette
[]?> Note!
The driver for the DPNET interface can also be found on the
"DAIRYPLAN" CD (to be ordered separately).
The driver can also be found on the Internet on the Westfalia home
page at "www.westfalia.com”.
Bearings
Storage temperature: -45 °C.... +60 °C
7160-90071-521

12-2002



Multi-Port Connection Set
Description

2.3

Multi-Port Connection Set

The multi-port connection set is the successor to the dual-port card. It is used in PCs
which do not have enough ports or which do not have any ISA ports.

The multi-port is intended exclusively to create the data connection between the
“DAIRYPLAN” program and the Westfalia peripherals connected (feed stations,
METATRON animal identification, TAXATRON, AUTOSELECT, ...).

Each Multi-Port connection Set has 4 DAIRYPLAN channels (currentloops) to which
16 peripherals can be connected in each case.

Installations which only require one DAIRYPLAN channel (current loop) for the
connection can use the “Single Port Connection Set”.

This is connected to an existing “COM interface” (see “Connecting a single port

connection set ”).

Note!

The Multi-Port connection set is notintended for applications other than
those listed here - and that would be considered as improper use!

Technical data

Multi-Port card 41094B (7162-9047-170)

Compatibility:

PCl 32-bit serial card for Pentium/MMX/Pentium
11

Operating systems:

Win 95/98, Win ME, Win NT 4.0, Win 2000

Modules:

4x FIFO 16C950 serial module with PCl bridge

Connection: SUB-D 37 socket
PCB: 2-layer 120mm x 79mm
CE: Interference immunity EN50082-1 (IEC

801-2/801-3/801-4)
Emitted interference EN50081-1 / EN55022

Data cable 37/37

Length:

1.8 m

Assignment:

37-pole 1:1, screened

CL transformer box

Data input:

37-pole SUB-D from Multi-Port card

Data output:

4 x current loop (CL)

Supply voltage:

9V AC/ min. 150 mA

Over-voltage protection:

Diverted to earth connection via varistors (earth
circuit connector)

Connection line min. 4mm2 (Cu)

Dimensions:

160mm x 120mm x 90mm

Plug-in power pack

Input data: 230V ~ /50 Hz | (USA: 115V)

Output data: 9V AC /300 mA

Connection line (sec.): approx. 2m
7160-9001-521
12-2002




Multi-Port Connection Set

Description
Includes
Individual parts of the Multi-Port connection set
Pos. Part No. Description
: 3 Electronic card, complete
7162-9046-020 (Multi-Port-Anschluss-Set) P, 230v
: 3 Electronic card, complete
7162-9046-030 (Multi-Port-Anschluss-Set) PCl, 115V
7162-9046-040 | Electronic card, complete (Uno-Port-Anschluss-Set) | COM, 230V
A 7162-9047-170 | Multi-Port card (type 41094B) PCI
B 7162-2380-060 | Data cable 37/37
B 7162-2380-050 | Data cable 37/9
q 7162-2680-040 | CL transformer box
D 7162-5986-000 | Plug-in power pack 230V /9v
D 7162-5986-010 | Plug-in power pack 115V /9v
E 4mm? Line for connection to the earth circuit
connector (green/yellow)
All of the parts listed above are included.
Note!

e Thedriver for multi-port card 7162-9047-170 in on the DAIRYPLAN CD
or can be downloaded from the WESTFALIA Homepage
“www.westfalia.com”.

e The driver for multi-port card 7162-9047-160 can be downloaded
from the WESTFALIA Homepage “www.westfalia.com”.

Bearings

Storage temperature: -10°C.... +70 °C

7160-9001-521
12-2002 7



DPNETInstall
Description

|2.4  DPNETInstall

Note!

DPNETInstall is included within the DAIRYPLAN Installation CDs from
version 5.090.

The DPNETInstall program is used to install and commission DPNET networks and
carry out any modifications which need to be made to hardware and software in
connection with new versions.

This involves entering various settings for the DPNET devices.

DPNETInstall also offers the following functions:
e Scanning the network in order to find out the current status of the installation.

e Updating of the equipment software by transferring Neuron and host
software.

e Displaying network information.

The milking parlour will not be fully operational until all the connected devices are
installed correctly. Once installed, the individual devices will be able to
communicate not only with each other but also with DAIRYPLAN.

The following steps need to be taken in order to operate a DPNET network:

e Install DPNET equipment in the installation as well as the cabling required (see
relevant user manual and assembly instructions for the equipment).

Installing DAIRYPLAN on a PC

Fit the DPNET interface and install the DPNET driver software
Enter settings in DPSetup for DPNET.

Install the program “DPNETInstall” and

- set up milking parlour settings

- Downloading equipment software
- install DPNET network

- Configuring the DPNET interface

7160-90017-521
12-2002



Safety information

|3 Safety information |

Use in accordance with the intended purpose also includes complying with the
operating manual and the conditions for inspection and maintenance.

Original Westfalia parts and accessories are designed specially for Westfalia
components. We would like to expressly point out that parts and accessories which
we have not supplied will not be checked or released by us either. Therefore the
installation and/or use of such products may possibly have a detrimental effect on
structural properties specified. The manufacturer will not accept responsibility for
any losses arising as a result of using non-original parts or accessories.

General safety information

Permissible operating conditions (pressure ranges, temperature ranges, air flow
measurements etc.) are to be taken from the technical specifications in this
operating manual and are not to be exceeded!

Disconnect electrical installations or equipment before working on them. Lock any
main or emergency stop switches to prevent them from being switched on again
and put up a warning sign.

Note that electronic components can be destroyed by electrostatic processes.

Work should only be carried out on the installation when it is disconnected from
the power supply.

“Unnecessary” hardware and software (games, Internet, ...) will add to the load on
the computer.
In the worst case this may cause the computer to crash resulting in data loss.

Selection and qualification of personnel, basic obligations

Read and follow the operating manual carefully!
Only use trained or briefed personnel!
Make sure that only "authorized personnel” have access to the computer.

Work on electrical parts of the machinelinstallation may only be carried out by
skilled electricians or by briefed personnel under the direction and supervision of
skilled electricians in accordance with electrotechnical regulations!

7160-90017-521
12-2002



Safety information

Saving data

Data is to be saved after and before amendments are carried out.
Generally speaking, data is to be saved at specific intervals and stored in a safe
place.

Make several sets of backups so that if there is an error in one there is still another
available.

Backups should be carried out after major changes to data.
Generally speaking, data is to be saved at specific intervals and stored in a safe
place.

Make several sets of backups so that if there is an error in one there is still another
available.

Voltage stabiliser

Since the power supply in agricultural establishments frequently fluctuates heavily,
it is advisable to use a voltage stabiliser to protect your PC and ensure there are no
interruptions in the supply.

PC-Protective Measures
PC-These measures (e.q. surge voltage protection, lightning protection) should be
agreed with your supplier.

Warnings and symbols

The following designations and symbols are used to denote especially important
information in this operating manual:

Note!
Special information on how to use the device economically.

Attention!

Special information or directions and prohibitions relating to loss
prevention.

L7 Reference to document / Operating instructions / Section.

7160-9001-521
10 12-2002



Installation guide

|4 Installation guide

The following steps are required to install or start up DAIRYPLAN:

These steps are described in the following sections in chronological order.

Check system requirements.
To make sure that all of DP’s features can be taken advantage of.

Section: System requirements (recommendations)
Fitting the interfaces and installing the corresponding drivers.
So that the DP PC can exchange data with the DPNET components.
Section: Interface installation
- DPNET interface
(See relevant section for explanation)
Section: Install DPNET interface
- Multi-Port Connection Set
(See relevant section for explanation)
Section: Multi-Port Connection Set Installation

Installation of the DAIRYPLAN herd management program
Section: DAIRYPLAN installation

- Obtain release (software key) from Westfalia Landtechnik.

Installation and start-up of DPNET components with DPNETInstall
(See relevant section for explanation)

Section: DPNET installation
Start-up DAIRYPLAN

Enter basic settings for DAIRYPLAN
Adjusting the program to the conditions of the installation.

Section: Starting up DAIRYPLAN

Functional test for the peripheral units.
Section: Feed System Test

Section: Testing METATRON

7160-90017-521
12-2002
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System requirements (recommendations)

|5 System requirements (recommendations)
Check the computer configuration
[]?> Note!
A note on working with dairyplan 5
Trouble-free working with DAIRYPLAN can only be guaranteed by
Westfalia if DAIRYPLAN has been installed in accordance with the
installation instructions. Other programs installed on the PC do not
generally interfere with the running of DAIRYPLAN. Nevertheless this
should be checked in each case.
The first step in the installation is to check the configuration of the computer. This
step is necessary to ensure that all of DAIRYPLAN's features will be able to be used
later on. After checking, please enter the computer’s configuration in the
installation description at the end of the instructions.
Information on the computer’s configuration can be obtained from Windows start
button under “Settings-> Control Panel-> System”.
Note!
Please note the “Recommended computer equipment” from the current
technical information publications from Westfalia Landtechnik.
PC requirements | recommendations
The following basic configuration is recommended for using DAIRYPLAN:
Minimum requirement | Recommendation
Betriebssystem e Windows 98SE
e Windows 98ME
e Windows 2000
o Windows XP
PCl-Steckplatze Free PCl slots for the peripherals connected
(see also section on "DAIRYPLAN information / slots”).
1 multi-port connection set = 4 channels (VC3)
Prozessor e Intel Pentium Il (800 MHz) or faster
o AMD K6-2, Athlon, Duron (800 MHz) or faster
Arbeitsspeicher (RAM) e 64 MB (up to 1000 animals)
e 128 MB (up to 2500 animals)
e 256 MB (more than 2500 animals)
Comment:
The working memory depends on the number of animal data records.
The number of animal data records required is calculated from the total
number of active (living) animals and inactive (dead) animals. An annual
growth of around 30% should be calculated-in if animals that leave the
farm are to be archived in the DAIRYPLAN data record.
The working memory required also depends upon the hardware
configuration, the operating system and the software installed on the
computer.
Please contact the PC dealer for any questions regarding computer
configuration.
Festplatte 4 GByte and larger. For DP, at least the following is required:
e 200 MB (up to 1000 animals)
e + 100 MB for every further 1000 animals
Drucker Graphics printer for Windows
7160-90017-521
12 12-2002



System requirements (recommendations)

Minimum requirement | Recommendation
Modem Internet access for the DAIRYPLAN online update

A model is especially necessary for LEONARDO farms.
The following devices have been tested with LEONARDO and can be
recommended:

e 3com US Robotics 56K fax modem (model No. 5630)
e Diamond SupraExpress 56 E Pro (V90 / K56Flex)

e Elsa Microlink 33.6 TQV

o AVM Fritzcard (ISDN)

CD-ROM-Laufwerk 24x (4x), the representation of long file names must be supported.
Diskettenlaufwerk 1.44" (data back-up for up to approx. 300 animals)
CD-Brenner (data back-up for more than 300 animals)

Monitor / Grafikkarte 17” Monitor

Monitor and graphics card should support a screen resolution of 1024*768
(800%600) pixels with , True color -16 bit” (256) colours.

Additional equipment for networking

e Network card for the PC (e.g. 100 MBit/s NE2000 or compatible network card)

e 100Mbit cable (e.qg. CAT.5) for connection to other computers.

Connection of 2 PCs with cross-over cable (patch cable for connecting PCs
without a HUB).

A network distributor (hub) will be required for 3 or more PCs.

max. Transmission .
Cable type distance speed PC requirements
CAT.5 80-100 m 100 MBit/s Network card and network software
Shield Twisted must be available on each computer.
Pair One network distributor (HUB) is
required for each network.

Network design using CAT.5 cable

pc 2 pcn

Cable type CAT.5
maximum length: 100 m

Network distributor
(HUB)

c Attention!
The use of 10 Mbit cables is not recommended!

An efficient network is necessary if DAIRYPLAN is to be used
effectively. A transmission speed of at least 100 MBit/s is required for
this.

Voltage stabiliser
Since the power supply in agricultural establishments frequently fluctuates heavily,

it is advisable to use a voltage stabiliser to protect your PC and ensure there are no
interruptions in the supply.

PC-Protective Measures

PC-These measures (e.q. surge voltage protection, lightning protection) should be
agreed with your supplier.

7160-9007-521
12-2002 13



Install DPNET interface
Installation of the interfaces

|6 Installation of the interfaces |

A DPNET interface or multi-port connection sets will be fitted to enable data to be
exchanged with the DPNET peripherals.
Once fitted, the corresponding driver will be installed.

[6.1 Install DPNET interface |

Handle all electronic components correctly to prevent electrostatic damage.

Conditions of application

[]? Note!

The system voltage (230 VAC) must be stable!

If the system voltage is not stable (significant fluctuations or voltage
dips), an uninterruptible power supply (UPS) must be connected
upstream.

Ambient temperature: 0 °C... 50 °C

Installing the DPNET interface

Attention!

When installing the DPNET interface, switch off the PC and disconnect it
from the mains (230 V)!

e Disconnect the mains and all connected peripherals from the mains.

e Open the PC housing carefully.

e Carefully install the DPNET interface in a free PCl slot and screw to the housing.
e Close the PC again.

[]? Note!

e With some motherboards, the AGP slot and the first PCl slot share an
Interrupt (IRQ). It is recommended that you start with the second PCI
slot.

Data line

c Attention!
When connecting the lines, the whole installation is to be disconnected
from the power supply so that no short-circuits can occur due to
uninsulated cable ends.

7160-9001-521
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Install DPNET interface
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6.1.1 Installation of the driver

Windows 98SE | ME | 2000 | XP
(DPNET Interface “XLON-PCI"”)

e Once the interface has been installed, restart the computer.
Windows will identify the new interface as it boots up.

e Install the driver by following the instructions on the screen
(the procedure is the same as when installing a multi-port card).

e PC configuration will be updated.

The entry “XLON Lonworks Network Interfaces” has been applied

Note!

The system properties (Hardware-> Device Manager)
can also be called up with this key combination.

Pausel

Call up the index card according
to the operating system in each
case under:

Win98SE:
“Start > Settings > Control Panel >
Device Manager”

Win2000:
“Start > Settings > Control Panel >
System > Hardware > Device
Manager”

Windows XP:

“Start > Control Panel > Printers
and other hardware > See also
System > Hardware > Device
Manager”

Select “Properties” to check correct
installation.

Index card “Properties”
e Transceiver ID:

Set as shown in the diagram
opposite!

e Service PIN:
Service PIN - message is sent

e Test Device:
A functional test of the card is
carried out.

e Reboot:
The card is restarted.

£ Geridte-Manager N

‘ Yorgang  Ansicht ‘ = ﬂ|&1@‘|@“@

46

7 Anschliisse (COMund LPT)
[+ L,Ei— Audio-, Video- und Gamecontroller
[ J_i__{ Computer
[#-E3 Datentrager
] 52 Diskettencontroller
[+]-&3 Diskettenlaufwerke
45 DYDJCD-ROM-Laufiwerke
-0 Grafikkarte
[+1-52 IDE ATAJATAPI-Controller
ez} ‘:'D M3use und andere Zeigegerate
[+ Monitore
[+ B8 Metzwerkadapter
[#-4& 5CSI- und RAID-Contraller
[+ M Systemgerate
] Tastaturen
[+ EED USB-Controller
= “_‘f RLON® Lon'orks® Metwork Interfaces

2 HLONPCT

Eigenschaften von XLON PCI

Allgemein  Properties | Treiberi Hessnurcenl

T
—  RLONPCI

- Setting:

Tranzceiver [D:

Automnatic Flush C ancel: 2

- Diagnostic

Semvice Pin Test Device Feboot

DH electronics GmbH, 2002

wi, slan. de

0K I Abbrechen-
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Install DPNET interface
Installation of the interfaces

Deinstallation

Ifyou want to uninstall the DPNET interface driver, select the entry in the index card
and then click on the "Remove” button.

The driver is then removed.

Note!
The computer must be restarted in order to accept the changes.

6.1.2 Set-up with DPNETInstall
Once the DPNET interface has been successfully fitted and the driver installed, after
installing the DAIRYPLAN herd management program the settings have to be made
with DPNETInstall.
Lo Section: Installing DPNET-> Setting up DPNET Interface

7160-90017-521
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Installing the multi-port connection set
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|6.2 Installing the multi-port connection set |

[]?> Note!

Installations which only require one DAIRYPLAN channel (current loop)
to connect Westfalia peripherals can use the “Single Port Connection
Set”.

When installing, make sure that the data lines are connected while the device is

disconnected from the power supply so that no short circuits can occur through the
uninsulated cable ends.

Attention!

When fitting the Multi-Port card the PC should be switched off and
separated from the mains (230V).

Handle all electronic components correctly to prevent electrostatic damage.

Conditions of application

The Multi-Port connection set should be installed in an office environment in the
direct vicinity of the PC.
The CL transformer box is to be mounted on a wall.

Ambient temperature: | 0°C...40°C

supply connections

A mains socket (230V AC) is required to supply the transformer box. This should be
provided by the client.

The mains voltage must be stable.

If the mains voltage is polluted by large fluctuations or voltage dips, an
uninterruptible power supply (UPS) must be connected in series.

7160-90017-521
12-2002
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6.2.1 Connecting the Multi-Port connection set

Attention!

If several cards are required, then these are to be installed individually,
one after the other.

e Insert jumper (1) as shown (only for multi-port card 7162-9047-170).
Multi-Port card (A)
The Multi-Port card is inserted in a free PCl slot. This requires the following steps:

e Disconnect the mains and all connected peripherals from the mains.
e Loosen the screws on the back of the PC and carefully open the housing.

e Carefully insert the Multi-Port card in a free PCl slot and fasten to the housing
with a screw.

Attention!

On most motherboards the AGP slot and the first PCl slot share an
interrupt (IRQ). It is recommended to start with the second PCl slot.

e Close the PC again.
Data cable (B)

The data cable (37/37-pole) is used to connect the Multi-Port card to the

transformer box. It is to be inserted into the 37-pole plug connector and fixed with
screws.

7160-9001-521
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Installing the multi-port connection set
Installation of the interfaces

Installation diagram for Multi-Port Connection Set

Transformer box (C)

The transformer box is to be mounted on a wall. Make sure that the housing is
mounted with the openings at the bottom. The lines are fed through a cable gland
into the inside of the box.

Attention!

e When connecting the lines the device and the whole installation
should be disconnected from the power supply so that no
short-circuits can occur due to the uninsulated cable ends.

e The shielding used for the data lines may not be connected to the CL
wall box. It is to be connected to the fuse block in the power supply
at one end.

In order to increase the protection against overvoltages on the data lines, the green
and yellow equipotential bonding conductor (4mm?2) is to be connected to the
equipotential bonding strip (EBS) from the customer’s electrical installation. It can

be made shorter or longer as required.

The connection facility should be provided by the client.

All work on the electrical system should only ever be carried out by trained

electricians.

)
7162-9047-170

7162-2680-040
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Legend

Multi-Port card TYPE 41094 Rev. B

PCI contact strip

SUB D 37 connection for CL transformer

Connection via data cable 7162-2380-060

Power supply

LED supply voltage

Equipotential bonding connection (EB) min 4 mm?2

SUB D 37 connection for Multi-Port card

Conductor gnlye 4 mmZ2, 2 m, connection to EB

Power supply for test plug (7162-9047-080)

~l x| ST Mmoo >

Channel 1...4, connection of the peripherals (for fuse block DS, DR, -)
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Installation of the interfaces

6.2.2 Connecting the Uno-Port connection set

e Install the transformer box (as described in the section on “Multi-Port
Connection Set”.

e Use the data cable (37/9-pole) to connect the transformer box to a free COM
port (COM1, COM2).

[]?> Note!

e Only channel “1” can be used on the transformer box!
e [tis not necessary for a driver to be installed.

e The Single Port Connection Set can be combined with a Multi-Port
Connection Set.
Make sure that the DP channels are correctly assigned to the COM
ports.

Installation diagram for Single Port Connection Set

7162-2680-040
A -
| © @ @ Rl
(L] 2 1
S @)
’ oflmn
L] 4 3
| H—TEL]
®/ =R ov o=
:< min 150mA ;:
AR 7N
N\ A VIV )
( T T J [ ] [ ] J

®
© 20

Legend
Connect with data cable 7162-2380-050 (to the PC COM port)
Power supply
LED supply voltage

Equipotential bonding connection (EB) min 4 mm?2

SUB D 37 connection for COM interface (PC)

Conductor gnlye 4 mmZ2, 2 m, connection to EB

Power supply for test plug (7162-9047-080)

SRS || ™Mm O

Channel 1, connection of the peripherals (for fuse block DS, DR, -)
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Installing the multi-port connection set
Installation of the interfaces

6.2.3 Installation of the driver

Multi-Port card TYPE 41094 Rev.B (7162-9047-170)
When the computer is switched on the PC devices installed are displayed.

The running display can be stopped with the “Pause” key, for example to view the
“PCl | AGP device listing”:

Bus No Device No Func No Vendor ID | Device ID Device Class IRQ
0 11 0 1415 9501 Simple COMM. 11
Controller
Note!

The “Device No” and “IRQ” display depends on which slot the Multi-Port
Card has been fitted!

Press any key for the display to continue.

7160-90017-521
12-2002
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Installation of the interfaces

Windows 98SE/IME

Note!

The following figures show the screens in Windows 98SE.
The screen may look slightly different in Windows ME!

When the operating system is started a new “PCl Serial Controller” identified.
Proceed as follows to install the driver.

The automatic hardware [Py
identification identifies the
Multi-Port card

Dieser Agsistent sucht nach newen Treibern fir:

PCI Serial Controller

Ein Geratetreiber ist ein Programm, das erforderdich ist,
damit ein Gerat furktioniert.

£ ZITieh Abbrechen |

To install the driver its [P NN
position has to be given.

I der Windows-Treiberdatenbank und in den gewahlten
Yerzeichniszen wird nach neuen Treibemn gesucht.

Klicken Sie auf "weiter", um die Suche zu starten.

e The driver is on the
DAIRYPLAN CD (version
5.018 and higher) in

[ Disketterlavfwerke

[~ CO-ROM-Laufwerk

directory
“\Driver\PCN\41094A\Win98 — it i Vg
ME”. ¥ Geben Sie eine Position an:

e The driver can also be | F:\Diiver\PLI 10544 in9BME =l

downloaded from the
Westfalia homepage at
www.westfalia.com.

£ Zuriick I Wieiter I ﬂbhrechenl

Carry out the installation step by step. At the end click on the “Finish” button

Next install the driver for the [ ¥
”PCl parallel port”.

Installation is to be carried out
as described above.

Dieser Agsistent sucht nach newen Treibern fir:

PCI Serial Controller

Ein Geratetreiber ist ein Programm, das erforderdich ist,
damit ein Gerat furktioniert.

£ ZITieh Abbrechen
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After installation

Once the driver has been installed, it is necessary to reboot the computer.

Then, in Start > Settings >

Control Panel > System >
Device  Manager” under
“Ports (COM and LPT) ” check * Modelle nach Typ anzeigen ¢ Modele nach Anschiuss anzeigen
whether all of the ports have ]

Algemein  Gerdte-Manager I Hardwareprofilel Leistungsmerkmalel

been installed correctly. = Anschilsse [COM und LPT) [
----- 5 COM-Anschiuss ([COM1)
COM5 ... COM8 are to be | " ECP-Druckeranschhuss (LPT1)
entered under "Connections = | - i OX16PCISES PCI Paralel port
(COM and LPT) ” The re/evant ----- # PCI Communicatians Port [COM5)
P T AP TP AU I S # PCI Communicatians Port (COME)
settings for the portsaretobe | " PO Communications Port (COM7)
entered in DPSetup (see | | F POI Communications Port [COMB) |
“Settings under DAIRYPLAN | | F PCIParallel Port (LPT2)
(DPS t ),,) ----- # Wittueller Infranot-COM-anschluss
ewp)).- 1 9 Vinueler Infrarat LPT Anschhiss
-5 CO-ROM
-2 Diskettenlaufuerk-Cantraller
[H-=x Festplattencantraller
BR Freikhanen =

Eigenschaﬂenl 2khialisisren I Entfernen I Cirucken... |

ok | abbrecken |

+ Pausel

The following entries are to [y N 1 |

be made under
"Multifunction cards”.

Note!

The system properties (Hardware-> Device Manager)
can also be called up with this key combination.

Algemein  Gerdte-Manager I Hardwareprofilel Leistungsmerkmalel

* Modelle nach Typ anzeigen ¢ Modelle nach Anschiuss anzeigen

52 Disketterlaubwerk-Cortroller

52 Festplattencontraller
Grafikkarten
Infrarotgerste

= Lauhveerke

S LonwWorks® |nterface

Ty Maus

@ toritore

- \> Multifunktionekarten

\> O=1EPCI954 PCI UART 2

=-EEr Netzwerkkarten

-G SCSI-Controller

=3 Systemkomponenten ;I

o Tl Tealabi.

Eigenschaﬂenl 2khialisisren I Entfernen I Cirucken... |

ok | abbrecken |

7160-9001-521
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Once the driver has been installed correctly, some of the settings for each new COM
port installed will have to be adjusted.

“Flow Control Type” is to be Eigenschaften von PCl Communications Part [COMS]
set to “None” for the new
ports (COMS5 ... COMS8 in the
example above) in the Device
Manager.

the slide control over to the
left.

7160-9007-521
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Windows 2000

After starting the Windows 2000 operating system, a new “16C95x serial port” will
be identified. The procedure for installating the driver is as follows.

The automatic hardware identification identifies the Multi-Port card and starts the
installation assistant.

Accistent Fir das Suchen neuer Hardware I

Hardwaretreiber installieren %

Ein Geratetreiber ist ein Programm, das das Ansprechen des Gerats durch das
Betriebzsystem emoglicht.

Der Assistent wird dis Installation des Gerats fertig stellen:

@ 16352 Serial Fort

Gerdtetreiber sind Progranme zum Steuemn der Hardware. Fiir das neue Gert sind
Treiberdateien eforderlich. Klicken Sie auf "wWeiter”, um diese Treibendateien zu
suchen und diz Installation 2u abzuschlisRen.

Wie mochten Sie worgehen?

% Nach sinen passenden Traiber fir das Gerdt suchen [empfahlen)

" dlle bekannten Treiber it das Geratin siner Liste anzsigen und den
entsprechenden Treber selbst auswahlen

Assistent Fir das Suchen neuer Hardware

Legen Sie den Installationsd atentrager des Herstellers
in das ausgewshlte Laufwerk ein, und klicken Sie dann

=
[ e, Abbrechen I

S

Dateien dez Herstellers kopieren van:

D:MDriverPCIS 411094 Ywdin2000 j Durnchsuchen... I

In Order tO insta” the COI’I’eCt Assistent fir das Suchen neuer Hardware
driver, itisnecessary to Specify  suche nach Treiberdateien

ItS pOSItIOI’) Geben Sie an, wo nach den Treiberdateien gesucht werden ol :Q\
e The driver is on the Nach Treiberdateien fiir folgende Gerate suchen:
DAIRYPLAN CD (version @ 16035 Serial Port
5.018 and higher) in '
d I reCtO ry Der Assistent sucht in der Treiberdatenbank und auf den angegebenen Lautwerken
. 3 3 nach passenden Treibem
'\DI’I Ver\PCI\4 7 094\Wln20 Kicken Sie auf "Weiter", um die Suche zu starten. ‘Wenn der Suchvorgang auf einer Diskette
00” oder einem CD-ROM-Laulwerk ausgefiihit wird, legen Sie 2uvor den Datentrager ein.
’ Andere Quellen fiir die Suche:

e The driver can also be I Diskellenlaufwerke
I CD-ROM-Laufwerke

downloaded from the ¥ Arrdors Biaall ancalici
Westfalia homepage at I icrossftindovs Lndate
www.westfalia.com.

< Zuriick I Weiter > I abbiechen

Carry out the installation step by step. At the end click on “End”.

Next install the driver for the “"PCl parallel port”. Installation should be carried out
as described above.

Once the driver has been installed, you will need to reboot the computer.

Note!

It is possible that Windows may find “new hardware” again. If so, the
details are to be specified as described above.

7160-9001-521
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After installation

Then, in ”Start > Settings > Control
Panel > System > Hardware > Device
Manager” under ”"Ports (COM and
LPT)” check whether all of the ports

_% Gerdte-Manager

=10l

|| Yorgang  Ansicht || = |BE| 2 ||§3ﬂ

schlisse (COM und LPT)

Druckeranschiuss (LFTL)
Kommunikationsanschiuss (COM1L)
Kommunikationsanschluss (COMZ)
OX16PCI954 PCI Parallel port (LPTZ)
ﬁ_Lyi PCI Communications Port (COM3)
PCI Communications Port (COM4)
PCI Cammunications Pare (COME)
[, “_'J PCI Cammunications Pare (COME)
r+. C@ Audio-, Video- und Gameconkrallzr

have been installed correctly.

COM3... COME6 are to be entered under
“Connections (COM and LPT)”. The
relevant settings for the ports are to be
entered in DPSetup (see ”Settings
under DAIRYPLAN (DPSetup)”).

[ Datentrager

(-5 Diskettencontraller

7)) Diskettenlaufwerke

8] TYDCD-ROM-Laufuwerke
| Srafikkarte

-5y IDE ATAATAPI-Contraller

| S Mause und andere Zeigegerdte
E Ionitor e

1 v I\'!ultifunktionsadapter

L e OR16PCIFS PCIUART S

G- S Metewerkadapter

B % Systemgerdte

[#-&g Tastaturen

Compuker

=
5
=

|

e [T~

SB-Controller
B %' XLONE Loniiorks® Metwark Inkerfaces

Note! . a
The system properties (Device Manager) can also be
called up with this key combination.

+ Pausel

Once the driver has been [ e ———— e I

installed correctly, the FIFO
settings for each new COM port
installed will have to be
adjusted. To do this, the slide
controllers are to be moved
over to the left.

hllgemeinl Settings  FIFOs |Datarate| Tleiberl

16350 [B]

Fiestore Defaults |

¥ Use FIFD buffers

— FIFD Interrupt Trigger level

Transmitker: J I}

Receiver

o S—

~ Receiver FIFD Flow Contral Thieshold:

Flawy O

o S—
L=}

Flaw OFff; )' 1

Ok, I Abbrechen
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Windows XP

When the Windows XP operating system is started, the newly installed Multi-Port
Card will be identified. Proceed as follows to install the driver.

Note!
The installation can be performed automatically (driver is searched for on
all available media) or manually (driver location is specified)!

Automatic ’nSta”atlon Assistent fiir das Suchen neuer Hardware

Willkommen

Mit diesem Assistenten konnen Siz Software fur die folgende
Hardwarekomponente installiersn:

PCl-Serieller Anschluss

7 Falls die Hardwarekomponente mit einer CD
) oder Diskette geliefert wurde, legen Sie diese
jetzt ein.

Wie mochten Sie vorgehen?

@ Software automatisch instalieren (empfahlent

() Software von einer Liste oder bestimmten Quelle
installieren (fur lortgeschrittene Benutzer)

Klicken Sie aut "wWeiter", um den Vorgang fortzusetzen.

Weiter > ] [Ahhiachan

Note!
If the driver is being installed automatically, make sure that the
DAIRYPLAN CD (version 5.020 or higher) is in the CD drive!

while the multiport card o

the individual ports are being
InSta”edl i the fO”O wing 1 E Die Software, die fiir diese Hardware instaliert wird:
message will appear on the S s

screen:

hat den Windows-Logo-Test nicht bestanden, der die Kornp atibilitst mit

windows <P uberpriift. fafarum ist dieser Test wichtig?)

Daz Fortzetzen der Installation dieser Software kann die komrekte
Funktion des Systems direkt oder in Zukunft beeintrachtigen.
Microsoft empliehlt strengstens, die Installation jetzt abzubrechen
und sich mit dem Hardwarehersteller fur Software. die den
Windows-Logo-Test bestanden hat. in Verbindung zu setzen.

| Installation fortsetzen | ’ Irmstallation abbrechen J

This test checks the driver for a Microsoft digital signature. The message shown
above appears if none is found.

To continue installation click on “Continue installation”.
To end the installation click on “Finish”.
This installation should be performed for the multi-port card and the COM ports.

Restart the computer after installation.

Note!
It is possible that Windows will again find “new hardware”. In this case
the installation has to be carried out again!

7160-9007-521
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Manual installation

In order to install the correct
driver, itis necessary to specify
its position.

e The driver is on the
DAIRYPLAN CD (version
5.020 and higher) in
directory
"\Driver\PCN41094\WinXP

”

e The driver can also be
downloaded from the
Westfalia homepage at
www.westfalia.com.

The following message will
appear on the screen during
installation of the multi-port
card or the individual ports.:

Assistent fiir das Suchen neuer Hardware

Willkommen

Mit diesem Assistenten kannen Sie Software fiir die folgende
Hardwarekomponente installiersn:

PCl-Serieller Anschluss

7 Falls die Hardwarekomponente mit einer CD
oder Diskette geliefert wurde, legen Sie diese
) oder Diskette geliefert wurde, legen Sie d
jetzt ein.

Wie mochten Sie vorgehen?

) Software automatisch instalieren (empfahlen)

(®i5oftware von einer Liste oder bestimmten Guelle }
dnstallieren (fir lortgeschiittene Benutzer]

Klicken Sie auf "wWeiter", um den Yorgang fortzusetzen.

[ Weiter > I [Abb'achan]

Assistent fiir das Suchen neuer Hardware

Wahlen Sie die Such- und Installationsoptionen. %

(%) Diese Quellen nach dem zutreffendsten Treiber durchsuchen
Verwenden Sie die Kontrollkastchen, um die Standardsuche zu enveitern oder

einzuschranken. Lokale Pfade und Wechselmedien sind in der Standardsuche mit
einbegriffen. Der zutreffendste Treber wird installiert.

[Iwechselmedien durchsuchen (Diskette, CD...)
Folgende Quelle ebenfalls durchsucher:
[D:ADriver\PCIN 094YWirsP v

(O Nicht suchen, sonderm den zu installierenden Treiber selbst wahlen

Verwenden Sie diese Option, um einen Geratelieiber aus einer Liste zu wahlen. Es wird
nicht garantiert, dass der von lhnen gewahlte Treiber der Hardware am besten entspricht,

l < Zuriick JI Wweiter > I [Abb'achan]

Hardwareinstallation

1 E Die Software, die fr disse Hardware installient wird:
.
Ox16PCI954 FCI LART g

hat den Windows-Logo-Test nicht bestanden, der die Kornp atibilitst mit
windows <P uberpriift. fafarum ist dieser Test wichtig?)

Daz Fortzetzen der Installation dieser Software kann die komrekte
Funktion des Systems direkt oder in Zukunft beeintrachtigen.
Microsoft empliehlt strengstens, die Installation jetzt abzubrechen
und sich mit dem Hardwarehersteller fur Software. die den
Windows-Logo-Test bestanden hat. in Verbindung zu setzen.

| Irstallation fortsetzen J ’ Installation abbrechen J

This test checks the driver for a Microsoft digital signature. The message shown
above appears if none is found.

e To continue installation click on “Continue installation”.

e To end installation click on “Finish”.

This installation should be performed for the multi-port card and the COM ports.

Restart the computer after installation.

Note!

It is possible that Windows will again find “new hardware”. In this case
the installation has to be carried out again!

28
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After installation

Then, in the Windows-Device Manager,
under "Ports (COM and LPT)” check
whether all of the ports have been installed
correctly.

g; Gerate-Manager

Datei  Akbon  Ansicht 7

WS 2 A

inschiidsse (COM und LPT)
g" ECP-Druckeranschiuss (LPT1)
j Kommunikationsanschluss (COM1)
,=”'i Kommunikationsanschluss (COM2)
n:%y’ O¥16PCI954 PCI Parallel park (LPTZ)
,l_luf’ PECI Communications Part {COM3)
,;‘ PCI Communications Part §COM4)
;5)" PCI Communications Part {COMS)
F\),f PCI Comrunications Pork (COME])
1, gudio-, Yideo- und Gamecontrolier
28 Eildbearbeitungsgerste
] »J Computer
| = Diskettencontroller
4 Diskettenlaufwerke
b DVDJCD-ROM-Laufwerke
@ Grafikkarte
(= IDE ATAJATAPL-Contraller
e Laufwerke
) Mause und andere Zeigegerate
-Eé Monitore
El \> Mulkifunktionsadapker
: \> OX16PCI954 PCI LUARTS
[+l E8h Netawerkadapter v

] = = = = = R - B =

Note!

The system properties (Device Manager) can also be
called up with this key combination.

COM3 ... COM6 are to be entered under "Connections (COM and LPT)”. The
relevant settings for the ports are to be entered in DPSetup (see “Settings under
DAIRYPLAN (DPSetup)”).

Once the driver has been

correctly installed, the “FIFO : — i —
settings” (COM port properties) | Aligemein | Settings | FIF0s | Data ate | Trelber|
have to be adjusted for each new

Eigenschaften von PCl Communications Port (COM3) @

COM-Port installed. 18650
Move the slide control (as shown
in the figure) over to the left. il
FIFD Intemupt Trigger lewels-
Tranzritter: /} 0
Feceiver: ! 1
i
Recarver FIFD Flaw Cantrol Threshalds
Flowdn: | 0

Flow DFf.

|
J

Bestore Defaults

[ ok ][ abbechen ]
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Uninstalling the driver for Multi-Port card TYPE 41094 Rev.B (7162-9047-170)

Note!

The computer must be restarted after uninstalling so that the changes can
be registered.

The Windows drivers for the multi-port card (7162-9047-170) are uninstalled
directly in Device Manager.

Windows 98SE/ME

Under “"Multi-function cards” mark the entries for the multi-port card (OX16PCI954
PCI UARTs and PCl function) and uninstall with the “Remove” button.

Windows 2000

Under “Multi-function adapters” mark the entry for the multi-port card
(OX16PCI954 PCl UARTs) and remove in the menu ”Process > Uninstall”.

Windows XP

Under “Multi-function adapters” mark the entry for the multi-port card
(OX16PCI954 PCl UARTs) and remove in the menu ”Process > Uninstall”.

6.2.4 Checking data connection

When DAIRYPLAN has been installed and configured and all peripherals have been
started up, the data connection can be checked in the program “Process control
(DPProcessControl)”.

A detailed display of all of the devices connected will appear in the program
“DPPort.exe”. The channels on which the devices are displayed must also appear
on the “DPSetup” main screen.

Note!

The DOS program “DPPort.exe” cannot be used to check communication
in systems with multi-port cards. Use the Windows program
“DPPort.exe”.

6.2.5 Setting up the multi-port card in DAIRYPLAN

The multi-port card is set up when DAIRYPLAN is started up.

For more detailed information on this subject, please see
Section Setting up the multi-port card with DPSetup

30

7160-90017-521
12-2002



General remarks
DAIRYPLAN Installation

|7 DAIRYPLAN Installation

7.1 General remarks

To install the DAIRYPLAN herd management program, have the unopened
DAIRYPLAN CD readly.

If the sticker on the side with the serial number has already been removed, it can
be assumed that this CD has already been installed.

Serial Numbers

Why a serial number?

The serial number is an encoded number which clearly identifies the system (not
the customer. The customer is registered under the serial number with the modules
installed. The serial number of the first installation is typical of the system. In the
case of an update the serial number from the previous program version is taken.
The serial number is used in the case of the product release together with the
software key.

When is a serial number needed?

The serial number is requested when installation takes place.

Note!

DAIRYPLAN cannot be installed if the serial number is incorrect or
missing.

Where do I find the serial number?

The serial number is on the sticker on the side of the DIARYPLAN CD box. If the serial
number has already been removed it can be assumed that this CD has already been
installed. If installing for the first time, obtain a new serial number should before
carrying out the installation!

When the DAIRYPLAN CD box is opened by tearing off the sticker with the serial
number, the customer is simultaneously declaring that he agrees with Westfalia
Landtechnik GmbH licensing agreements.

For more detailed information on this subject, please see
Section DAIRYPLAN licence

”"Readme.txt” Instruction File

First of all, please read the document "README.TXT” on the DAIRYPLAN CD. This
document contains important current information. To do this, insert the
DAIRYPLAN CD into the CD ROM drive. Double click on "README.TXT” in
“Windows Explorer” to select the document.

There is a choice of ways to install DAIRYPLAN which are now described.

Networks
Note!
If DAIRYPLAN is to be installed in a network, see the section on
"DAIRYPLAN Network Installation”.
7160-90071-521

12-2002
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(7.2

Types of Installation

7.2.1

Choose from the following types of installation.

First Time Installation
DAIRYPLAN is not yet on the computer

Upgrade to DAIRYPLAN 21
Upgrades an old version to the current version

DAIRYPLAN 21 Update
(e.g.: DAIRYPLAN 21 to DAIRYPLAN 21 Service Pack 1)

Online-Update
Current program updates can be loaded if you have access to the Internet.

Module Installation
A new module, e.qg. module P-M for milk metering is to be added to the existing
DAIRYPLAN system.

Language Installation
Installing an additional language on an installed version.

First Time Installation

Place the dairyplan 5 CD in the CD drive.

The DAIRYPLAN installation program starts automatically.

If it does not, select the DAIRYPLAN CD with Windows Explorer and start the
program “CDAutoPlay” on the CD.

the opening screen in the installation program, with details on the version,
appears. Click on “Install” to continue.

Select the language required and click on “Continue” to continue.

The serial number asked for is on the sticker at the side of the CD box. Enter the
serial number if the relevant field and confirm the entry with “Continue”.
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e Once the serial number has been checked the “dairyplan 5 installation”

window appears
DAIRYPLAN Installation ] |

—Aut der Installation 4@

£ Angtalliere DAIFTPLAN Yollversior

" Installiere DEMO Yersion

{0 WPDATE DR LA

WP DE warge s ErELa Meremp
i & BEAEH B Faiiiaen

b D BT Bl

Eirstel e Statme

5 EE S G G

alEr RN emstalieen

o [FDPSTLser

Mach  |CDaiyFin

‘ Neue Installation

—Yerzeichnis L 2 I

“Windows Taskleiste und Autostartordner 3

V' I+ Programm - Menii
Plad IC:'\WINDDWS\SlarlmenUKF‘rogra

¥ Starten von DPProcessControl
Piad IC:'\WINDDWS\SlarlmenUKF‘rogra

LZunick, Beenden

Installisren

1 | “Type of Installation”

Under “Type of Installation” select the option you require:

e Option “Install Dairy Plan Version”.
A bought version is installed. The software key and further
information are then necessary

e Option “Install DEMO Version”.
A demo-version is installed. No further information is necessary.

2 | “Directory”

circumstances.

In this section select the directory where DAIRYPLAN is to be installed.
The directory given should only be changed in exceptional

set.

3 | “Windows start bar and Autostart folder”

The option in "Start menu / Programs” allows DAIRYPLAN to start
automatically when the computer is restarted. This option should be

A desktop icon (shortcut) is also set up for direct access.

The option “Start from DPProcessControl” activates the control of
peripherals when the computer is started. This option should also be
set. This option should be passed over in a DEMO version.

e When all the options have been set, confirm by pressing the “Install” key. When
installation takes place the computer will check the capacity of the hard disk.
If there is not enough capacity available, this fact will be displayed on screen.

7160-90017-521
12-2002
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e After the individual parts of the program have been copied onto the hard disk
the "Program Options” window appears.

e Enter details in the “Program Option” window:

Programm Optionen |

— Programm Ophionen

ooy 1
F bl HH S (et H R S e o ke e ider atrer e Sehate oder D

T |=n |y

F\, b ol HM-D Opticn HM-D izt flir das Datenaustauzch - Frogramnn kIKO
erforderlich.

[az Hi - bk odul erlaubt den D atenaustavsch mit einem
Hand Held Computer [Palrm Filat)

F M adul HM-H Mudul HM - H fur nationale D atenaustauschprogramme [HIT
in Devtzchland)

F bl P-F Diie Dpti_on P-F izt fiir diz Steverning der Futterbasxen
erforderlich.
F M ol F-h Dptinn P-4 ist fur die autqmalische Milchmengen- sowie die
Leitwertmassung eforderlich,

F Option P-S ist flr die Prozessteuerungen der Akheitat,
v .
e Selektion und ‘waage erforderlizh.

g Option P-L izt fur die Stewerung des Westfaha aMIS
F Mo LEONARDO erforderich

—AnzZa el | lendatensalze

) Keme [Euswetingshope] wfahlen Sie die maximale Anzahl Tiere die Si 2 I
abzpeichen wolen, WICHTIG: inaktive
030 B0 €120 €7 250 [archivierte] Tiere werden mitgezahlt.

f+:500 £ 1000¢ 3000¢ Mehr ‘

Bizher genutzte Optionen Meue Optionen, die Sie
f-30 HM-D P-F Pbd P-S K500

ST EN | Beenden |

1 | “Program Options”

The modules shown in the window are available for selection, e.g.:
“P-F” for controlling the feeding/calf boxes. Select the options
intended for the farm her. Multiple selections can be made.

2 | “Number of animal data records”
Select the maximum number of animals envisaged for operation.

Note!
See also section on “System requirements; Working memory”
The options selected are shown in the “Program Options” window

e When the details are confirmed by clicking on the “Next” button, a note about
the software key appears

[]?> Note!

In order to protect its rights, Westfalia Landtechnik has given
DAIRYPLAN a software key. This will approve your program. If it is not
approved the program can only be used to a very limited extent.
Approval is issued by Westfalia Landtechnik itself in Oelde.

The program will only be approved if the modules installed
have actually been purchased.

e Confirm the instruction window.
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e The installation is now complete and the following window appears:

DAIRYPLAN ]|

Inztallation beendet

—Waz woller Sie als nachstes tun?-

(A E o

DAIRYFLAN Menti

0Ry

DalIRYPLAM Registiensn

Press the keys indicated to choose from the following options:
A | Start DAIRYPLAN.
B | Call up registration form.

C | Close application.

For ”Starting out” with DAIRYPLAN, please see
(L7 7160-90. . -520 DAIRYPLAN Operation
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7.2.2 Upgrade to DAIRYPLAN 21

Update an existing version of DP to DAIRYPLAN 21.

From (already on the PC) Upgrade file
DAIRY PLAN 4 (DOS version) DP4.xxx
DAIRYPLAN (Windows version) dairyplan5.xxx

In Dairy Plan 4 start the “Test Data Stock” function. Correct any errors before
the function is started.

Note the number of animal data records and check whether the “Licensing” is
sufficient.

Back up the current record using the corresponding function from the
“Services” main menu. In addition, the whole dairyplan 5 directory can be
copied into a separate back-up directory.

Quit Dairy Plan 4 in the usual way.
Insert the DAIRYPLAN CD to install the upgrade.
The installation program automatically switches to the upgrade procedure.

Follow the steps for “New installation” until the “DAIRYPLAN Installation”
window appears.

The installation program automatically identifies that there is a Dairy Plan 4
version already on the system and therefore sets the installation option to
“Upgrade DAIRYPLAN"”. Confirm the details by pressing the “Install” button.

Now follow the instructions under the heading “New Installation” from the
section entitled “Installation / Types of Installation”.

Attention!

The old Dairy Plan 4 entries must be removed from the "Autostart” group
of programs.

7.2.3 Update DAIRYPLAN 21

Update DAIRYPLAN 21 system which has already been installed with a more up to
date version.

Start “Check system data records”.
Correct any errors before the function is started.

Now backup the current (present) data record with the function ”Services -
DAIRYPLAN data backup” in the main menu.

End all DAIRYPLAN programs including process control “DPProcessControl”.

Follow the steps for “New installation” until the “DAIRYPLAN Installation”
window appears.

The "Program Option” window will not be displayed because the installation
program automatically recognises that there isa DAIRYPLAN version already on
the system and therefore sets the installation option to “Update Dairy Plan 5.
Confirm the details by pressing “Install”.

Now follow the instructions under the heading “New Installation” from the
section entitled “Installation / Types of Installation”.
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7.2.4 Online-Update

Information on DP Online Update
DAIRYPLAN update files can be loaded from the DAIRPYPLAN update web site at
any time, quickly, conveniently and free of charge.

The requirements for an Online Update are as follows:
e Internet connection

e Internet Browser for the World Wide Web ( AOL, MS Internet Explorer,
Netscape, ...)

How do I carry out an online update?
The DAIRYPLAN update web site starts with a “Home Page”, from which the pages
giving instructions for the various countries can be accessed.

[]? Note!

Unlike previous versions of DAIRYPLAN where just one update record
updated both the program and the language, both a program and a
language update are now required for a DAIRYPLAN Update.

An online update will not update any Dairy Plan 4 versions.

e Log onto the Internet.

e Enter the Internet address, “http:llwww.westfalia.com” in the
browser.
Then select “Service For You -> Updates”.

e The Home Page lists the languages which are currently supported by
DAIRYPLAN. When a language is selected the program update pages will
appear in the language required.

7.2.5 Options Installation

DAIRYPLAN has a modular structure.

If DAIRYPLAN js to be updated, by milk metering for example, the option for this,
P-M, then has to be installed.

This requires the following steps:

[]? Note!

Each additional option requires a new software key. The costs of the new
options are calculated by the Technical Centre or the dealer if they have
not been obtained before.

e Put the DAIRYPLAN CD into the CD ROM drive.

e The "Type of Installation” window appears. Click on “Module Option”.
e The “Program Options” window will open.

e Click on the new options required and confirm.

e Continue to follow the instructions

7160-9001-521
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7.2.6

Language Installation

DAIRYPLAN can be installed in various languages.

All languages are contained on the DAIRYPLAN CD. The language can therefore
be reinstalled.

This requires the following steps:

e Follow the steps for “New installation” from the section “Installation”; "Types
of installation” until the window for “Language selection” appears.

e Click on the required option and confirm the details given.

[]?> Note!

DAIRYPLAN has been tested with Windows.

Westfalia Landtechnik cannot provide any support if other network
software is used.
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DAIRYPLAN Installation
7.3 DAIRYPLAN network installation |
Installing DAIRYPLAN in a network generally requires the following steps
(depending on the range and type of network):
e Installing DAIRYPLAN on the "Master”
e Creating a data link with the computers
e Configuring the master computer
e Configuring the slave computer
[]?> Note!
We recommend working with DAIRYPLAN for a while without
connecting to a network. If there are any starting problems with the
installation, these are easier to solve without a complex network system.
When the system is working smoothly with the connected hardware and
the user has become familiar with DAIRYPLAN and the PC, the network
connection can be started.
Installing DAIRYPLAN on the "Master"”
So that the computer always starts in master mode, please enter the following line
at the end of the "Autoexec.bat” file:
Set dpnet=master
Setting up the data link with the other computers
Usually there are 4 steps in the process of setting up a data link with the PC to be
connected into the network:
e Installation of the networks cards (e.g. 100 MBit/s NE2000 compatible network
cards) in each computer
e Installation of the network cable to link the computers (e.qg. CAT.5)
e Installation of the network software on the computers
e Setting up and configuring the network components on the computers
Note!
In setting up a network it is advisable to seek the advice of the computer
supplier. You should follow the instructions in the manual very carefully.
7160-9001-521
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Configuring the master computer

On the "Master” or Server PC, the drive or directory set for DAIRYPLAN must be
released for the network.
With Windows, “Windows Explorer” will be used for this.

e With Windows Explorer, select the hard disk drive on which DAIRYPLAN has
been installed (generally “C:”).

e When the right mouse button is clicked a menu appears. Select “Release”.

e Under "Drive Properties (C:)” in the “Release” index card, fill out the individual
areas as follows:

- "Release as:"”-> Release name : "DAIRYPLAN DISK”
- "Access type:”-> “Read/Write access”.

- “References:” ->"Read/Write reference” enter a *“Reference”, e.g.:
DAIRYPLAN

Note the computer name under "Control Panel - Network - Identification” from the
“Computer name” field.

Note!

The Master must release write access as described above because
otherwise other DAIRYPLAN computers will not be able to access it!

Configuring the slave computers

The slave or client PC now has to be linked with the drive released in step 4).
e In Windows select "Extras” from "Windows Explorer”
e Establish the link using the function ””Connect “Network Drive”.
- In the input field "Drive”, select a free drive (e.g. "\G").

- In the "Path” field enter the names of the specified computer- and release
for the Master computer, as shown.
(e.g. "\Computer-Name\DAIRYPLAN DISK”).

- Tick the box “Re-establish link on starting”. The link will then be established
automatically when the computer next re-starts.

- Hit the "OK” key, to set up the link.

e If the connection can be made, in the next dialogue box enter the reference
(e.g. DAIRYPLAN) that you have given on the Master computer.

e Select the new drive using Windows Explorer.

e Inthe DAIRYPLAN folder, click on “DPMenu”. Herd management jobs can now
be performed.

To always start the computer in Slave mode, at the end of the “Autoexec.bat” file
please add the line:

Set dpnet=slave

7160-9001-521
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7.4  DAIRYPLAN licensing |

Licence rights

DAIRYPLAN is subject to Copyright.

In order to protect its rights, Westfalia Landtechnik has given DAIRYPLAN a
software key. This will approve your program. If it is not approved the program can
only be used to a very limited extent. Approval is issued by Westfalia Landtechnik
itself in Oelde.

The program will only be approved if the modules installed have actually
been purchased.

Approval
Approval is given either by the Technical Centre of by the dealer if:

e the serial number is the right one,

e if software key 2 has been issued.

Software key 1 | Software key 2

When is a new software key required?

Software key 2 is a coded number which is keyed in within 30 days and is always
asked for if:

e you are upgrading Dairy Plan 4 (DOS versions) to DAIRYPLAN (Windows
versions).

e you are installing for the first time
e you are changing the modules installed.

e the DAIRYPLAN program recognises thatitis running on another hard disk. This
may occur if:

- the files have been copied onto another computer,

- the hard disk has been re-formatted, or if

- a new version of Windows has been installed on the hard disk.
The software key is obtained from the Technical Centre or the dealer.
How does the software key system work?

For the first 30 days after a new installation, you can change to and work with the
required part of the program simply by pressing “Close”. After this time the
program functions will be blocked until software key 2 is entered.

The serial number, the options installed and software key 1 will appear. Enter
software key 2 in the empty field.

If application for the 2nd software key is to be processed, click on the “Process
application” field. The application form will be processed via this field with a
corresponding input form.

Providing the fax number is optional. It simplifies subsequent provision of the 2nd
software key.
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Application Form for Second Software Key

With the information give, DAIRYPLAN creates the following application form.
This form can be printed out directly. If there is no printer available, in urgent cases,
itcan also be stored in a file, e.g. on a diskette so that it can be printed from another
PC.

Application Form

'E'g- DPRegister.itf - DPRegister

Datei Bearbeiten Ansicht  Hilfe
=R
Abfrage des DATRYPLAN C21 Software Schliissels

(wrird fiar Options - Mo dule und UpGrade Versionen bendtigt)

DAIRYPLAN untetliegt dem Copyright. Um unetlaubter BEentzung vormubeugen, wird das Programm durch ein Softarare - SchlGsselsystem
geschiatzt. Der "2, Software - SchilGss el” mul innerhalb von 30 Tagen nach der Installation eingegeben werden. Ansonsten wird das System
blockieren. Bie werden den Software - Schiltssel von Threm Handler ethalten, von dem Sie Ihe Wersion erstanden haben.

Bitte drucken Bie disses Formblatt aus und schicken es wtiters chirieben an Thren Héndler. Digser wird Thnen den bendtigten Softwate -
Schltssel aushindigen.

Anschrift Hiindler
Kundentlr. (Handler) 123456
Addresse Miller GmbH
Landweg2l
532302 Oelde - Deutschland
Email - Adresse monteun@ e de
Fax Nummer +40 2522 099000
Telefortmimmer +40 2522111111
Installiert von Iuisller
Anschrift Knnde
Autragshy. 400123 456
Name Landmann
Addresse Landweg 22
50302 Oelde
Deutschland
Emmail - Adresse Landmann@ g de
Fax Nummer +40 2527 32EER3
Telefortmimmer +A0 2522 222322
System Information
Installation s date Datum o Apr, 2002
Wersion 509905
Serientr. (Originall GE23M002
K auf Optionien HM-D HM-M D-F B-M D-S

Software Schlitssel 1

Software Schltisszel 2

Begrindung Antrag

8554 2628 6518 3126 3269

(arird bei der dinbarort hier eingetragen)

Bitte ankreuzen: (| ) Meuvinstallation () Upgrade
() 3onstiges - Bitte Begrindung unten anfiigen

Funde UnterschriftiTiatum

Handler Unte rschrift/Datum

Westfalia Landtechmik GrubH, ein Unternehmen der GEA - Grappe

Sonstice Anmerkungen:

Bereit ’_ HUM. i

When the form has been printed, fill in the reason for the application. The
signatures confirm that the details given are correct and that the signatories agree
to the conditions covering the request for the software key.

Westfalia Landtechnik enters software key 2 in the application form submitted and
provides it to the customer via the technical centre/dealer.

On receipt the second key is entered in the entry window described above.
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|7.5  Uninstalling DAIRYPLAN |

e End all DAIRYPLAN programs (see also section on “DAIRYPLAN information /
Ending DAIRYPLAN").

e In Windows “Start - Programs - dairyplan” click on “DPUninstall”.
e Confirm that you want to delete all files by clicking on “yes - remove”.

e Delete the "dairypln” directory using Windows-Explorers.
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|8 DPNET Installation

The network components are installed with the program DPNETInstall.
The DPNETInstall program can be started as follows after installation:
e Directly from this DAIRYPLAN directory
e From DPSetup, in the menu “Devices->DPNETInstall”
Special features of the initial start-up process

When the program is started up for the first time, the window displayed will appear
automatically. The following details must be entered once for the DPNET interface.

- DPNET-Interface: “Xlon PCI” x|

In exceptional cases, it may be . .

necessary to select a different
interface_ % Rlan POl Interface Mr. |D vI
- Interface No.: “0” " HonlSE
The first card installed has the
number “0”. © PCLTAZD
Finally, you will be requested to scan

the network.

Abbrechen |

On starting up, the program window displaying the installation tree and devices
based on the information in DPSetup will appear.
Because their status is still unknown the devices will be shown in grey or red.

{4 DPNetInstall o [=] S|
Eﬁ Datei Ansicht Netzinstallation Geratesoftware Gerdte-Info Verboroen  Hife =15 x|

CERERE

Futterstationen
Melkstand 1 (FGM)

g Standby Modul 1 (103/1), Neuron ID 777

— Parl

=" gide Reihe 1

Tarsteuerung 1 (102{1), Meuron ID 777
Metatron 1 {11}, Meuron 1D 777

Metatron 2 {1/2), Neuron 1D 777

FEFEE]

Parl
— Side

I
o
@

=

22

Metatron 3 (21}, Meuron 1D 777

) |

Metatron 4 {2/2), Neuron ID 777

|4 Sel  Selektion/Waage

The PC shown in the tree should have a green background otherwise the DPNET
interface has not been installed correctly.
Ifthisicon is red, check the settings under “Network installation->Interface Setup”.
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Program symbols

The following pictograms may appear in the tree.

m Gate control

(]

Box control unit —

=N

METATRON
_.,

&

Stand-By

= Close/open
- | directory

Here, the background colour provides information on the installation status.

Background colour

Example

Installation OK

1l | DPNET Installation-METATRON
+—=l|| Interface O.K.

re Installation incomplete -
IV Re-install

Installation of METATRON
incomplete. Re-install.

Installation incorrect - Re-install .

Installation of gate control
system incorrect. Re-install.

7160-90017-521
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|8.1  DPNET network installation | Update

Requirements

e DAIRYPLAN/DPNETInstall are installed.
e DPNET Interface (including driver) is installed.

e The equipment for the DPNET network which is to be put into operation, (eg
a milking parlour or a feed box unit), must be assembled in the milking parlour
and connected to the DPNET interface of the PC.

e Settings have been entered in DPSetup for DPNET.
Before the network can be installed the installation has to be configured in
DPSetup. To do this, start the Wizard with “DPSetup->Wizard->Start”.
Once all the forms have been filled in, the milking parlour is configured and
DPNETInstall can be started up.

Installing/lupdating

In order to install or update a network, the following points are to be carried out
in the order specified:

[]?> Note!

The installation described is restricted to essential components.
If necessary, detailed information / instructions on these points is given
in the Section on “Installation steps”!

e Start up the DPNETInstall program
- Directly from this DAIRYPLAN directory
- From DPSetup, in the menu “Devices->DPNETInstall”
e Scan the network
- Call up the menu “Network installation -> Scan network”.
- Tree will be displayed.
e Download equipment software (for new device or update).

[]?> Note!

During initial commissioning, only one Neuron download has to be
carried out for the gate/box control system as all other modules are
supplied with plug-and-play Neuron/host software.

- Select the device to be installed in the tree (background colour red or grey).

- In the menu ”“Device software”, select “Neuron Processor” or “Host
Processor” (for METATRON).

- Call up via Tree (only works when updating) or Service Pin (initial
commissioning and updating).

4

WWollen Sie die Software auf das auzgewshite Gerat Lbertragen
oder wallen Sie das entprechende Gerat durch dricken des
Sewice Pins festlegen?

| Baum | Semice-Fin Abbrechen

Attention!

During initial commissioning, call up the device using the Service
PIN!

(see corresponding user manual for the device).
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The program will propose the correct software automatically.
If necessary, a message will appear indicating that the latest software
version is already available.

Carry out the download.

Download the next device.

e Assign addresses to DPNET devices

Attention!

Please follow the relevant user manual for the device when installing
DPNET equipment! (eg for METATRON)

Print out the installation tree (to help with installation)

In the menu ,Network installation”, choose between ,Address
specification->All”  (installation of all devices) or “Address
specification->Individual” (installation of individual devices).

Send the PIN to DP for each device one after the other (in the order shown
in the installation tree).

Geriteinstallation x|

Bitte drucken Sie den Service Fin Metatron 4 [2/2)

Aftersending the PIN, wait for the ,, Wink” from the device (e.g. METATRON
flashes 3 times).

Next device.

e Scan network again
Once all devices have been linked up, a final check will be carried out on the
network.
If installed correctly, all pictograms will have a green background!

e Close program
“End” in the “File” menu

[]?> Note!

After installing a METATRON device, a final check should be carried out
on the METATRON settings on the device and they should be resent if
necessary!

The installation/update is complete.
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|8.2 Installation procedure

8.2.1 Scan the network

When scanning the network, DPNETInstall searches for current devices (installed in
the milking parlour and connected to the interface).
While doing so, the addressing and configuration of all devices found are checked.

If devices are found with addresses which are not within the permitted range or
which are already present, this is indicated by the background colour of the device.
An error message will also be given in some cases.

The software version of the devices is also checked.
If there is a more recent version of the software this will be shown in the text of the
installation tree.

Background colour

Installation OK

Installation incomplete - Re-install

Installation incorrect - Re-install

If the milking parlour has been installed correctly, the following image will be

shown:
{4 DPNetInstall f =3
Eﬁ Datei Ansicht Netzinstallation Geratesoftware Gerdte-Info Verboroen  Hife =15 x|

FERRE
% dpnet PC

@ Fed Futterstationen
=|
|

" Metkstand 1 (FGM)

g Standby Modul 1 (103/1)

Parl

=" gide Reihe 1

3 _ Metatron 2 {1/2)

Tarsteuerung 1 (102/1)

Parl )
=" gide Rehe2
1 .J Metatron 3 (2/1)

3 _ Metatron 4 (2/2)

|4 Sel  Selektion/Waage

[]? Note!

During initial commissioning of DPNETInstall, you will be automatically
requested to scan the network.

Start the scanning process

e In “Network installation” select the option “Scan network”.

7160-9001-521
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8.2.2 Downloading equipment software

DPNET devices operate using a Neuron processor (METATRON using Neuron and
host) on which corresponding software may have to be run.

e For initial commissioning (only applies to gate/box control system)
e For updating (applies to all DPNET devices)

To do this, a standard control module is used for the gate and box control systems
which is supplied with universal test software.

This control module eg a box control unit cannot be used until you have
downloaded the corresponding equipment software.

Before the network can be installed, the corresponding software must therefore
be loaded into this module from the menu “Device software” with “Neuron
Processor” or “Host Processor”.

The type of download will depend on the processor for the DPNET device used to
run the equipment software.

- Neuron processor
Network processor used to run programs for single devices.

- Host processor
Processor which is used to run additional programs for complex devices
(METATRON).

The following table shows the existing device-specific processor software.

Device Neuron Host
Standby X -
Gate control X -
Box control unit X -
METATRON P21 X X
METATRON S21 X X

7160-90017-521
12-2002
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Download process

[]?> Note!

When installing for the first time, a Neuron download only has to be
performed for the gate / box control unit because all of the other modules
are fitted Neuron/Host software that is ready to run.

e Select the device to be installed in the tree (background colour red or grey).

e [In the menu “Device software”, select “Neuron Processor” or “Host Processor”
(Host for METATRON only).

e Call up device

Attention!

During initial commissioning, call up the device using the Service PIN!
(see corresponding user manual for the device).

To do this, you select whether x

the device is to be called up via

the Tree or by CIICklng on wWollen Sie die Software auf das ausgewdhlie Gerdt Ubetragen
Service Pin. oder wollen Sie das entprechende Gerat durch diticken des

Service Ping festlegen’?

Baum I ServiceFin Abbrechen

“Service PIN" - for first installation and update
Is released on the device and sent to DPNETInstall.

DPNETInstall will wait for [T
the Service Pin for the device

Bitte Service-Fin diucken: Metatron 1 [147]

Gerat Lbersprinash | | Abbrechen I Reibe Lberspringen |

After activating the Service x|

Pin on the device, the file to
be transferred will be : "-q Die Folgende Cuatei wird nun bertragen

displayed. '
A DairyPlntdpnetiglobaliP2136 &% nue

(] 4 I abbrechen

Confirm with “OK” to transfer the software to the device.

When downloading the host [T EE———"
software, a progress indicator will

appear as the quantity of data to be b [Metatan
transferred is considerably larger Rieihe: o
than the quantity of data required for
the Neuron software. Platz: |1
Fortachritt: -
Wiederhole ID—
Telzaramme

50
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- “Tree” - only works for an update (devices already installed)
The whole process can be operated directly from the computer.
You only have this facility if the device selected has already been installed
in the network.

Press the “Tree” button to display which file is being transferred. Confirm
with “OK".
The program will propose the correct software automatically.

If the current version is already installed on the device, a message will appear
indicating that no download is necessary.

Carry out the download

After the Neuron software has been transferred, the device will have to be
re-installed. DPNETInstall will do this automatically.

Continue the download process for the next device.

7160-90017-521
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8.2.3 Group download

Note!
Requirements for a group download:

e The devices which are to receive the new software have already been
installed.

e All devices are of the same type.

A group download enables software to be downloaded to several devices in one
go.

DPNETInstall controls the transfer automatically so that the user can perform other
activities during this time.

Once the group download had been completed, the whole process can be checked
in a progress window.

Starte MewronD ownload

Die folgende Datel wird nun ubertragenllk: Y\ Dp51sD ebugtdpnetsaloballP2133_a3nke
Datel wird Ubertragen, bithe vwarten,

Weuran 5 oftware efolgreich Ubertragen

Irztaliene Gerat

Dig folgerde Datsi wird nun UbertragenlliC Dps1v0 ebugtdprethalobalP21233_a2naee
[Diatei wird Libertragen, bitte vaarten.

Neuron Software sfolareich ubertkagen

Instaliere Gerat

Diownload volstandig durchgefiibt

Bbbrechen

Group download, Neuron processor

To transfer neuron software to several devices:
e Select the type of device in the “tree”.

e Start the group download via the menu “Device Software->Group
Download->Neuron Processor”.

e Area (1) lists all devices in the
installation which correspond
to the device type selected.

METATROM 1(141)
METATROM 2(1/2)

METAT 1
Hirzufigen ETATROM 3 (143

AZTATRON 1 (1/1)
FETATRON 2 [1/2

e Copy all of the devices to be METATRON 3 (173
METATRON 4 [2/1)

updated into the selection list METATRON 51222
with the copy buttons (2). Ertfsinen

e Confirm with OK (3). me
Th  neuron  software s e
automatically transferred to all PO LD
of the devices in the selection
list, one after the other.

i

i

3 0K Abbeechen I

7160-9001-521
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Group download, Host processor
Note!
Group download is useful if there are more than three devices to be
updated.

Group download enables the host software to be transferred to all of the devices
in a milking parlour row at the same time.

[]?> Note!

e A group download is not possible with the Service Pin.

e Only those devices which require the same software version can be
updated at the same time.

e Devices which are not compatible with the software version to be
provided (this depends upon the device selected) are removed from
the download list and must be transferred individually.

e At least METATRON Host Version 1.20 is required for the group
download.
If this has not yet been installed, all of the devices to be updated must
first be supplied individually with new software.
A special Host Version 1.19 is available for this.

To start a group download:
e Select a device of the required series in the “tree”.

e Select “Device Software->Group Download->Host Processor”.

e The current host software is transferred [Emr—r— x|
to all devices in corresponding series.

Gerat: Metatron

- Ifafaultoccurson adevice during the
transfer, the transfer to that device
will be interrupted and must then be Plat
carried out separately.

Reihe:

Fartzchritt:

“Wiederhaolte

Telegramme

?‘TW

e Once the group download has been completed, all of the devices that have
been updated will be listed in the progress window.

Start d=s Gruppen-Downlaad der Hast-Applikation
Hast-Applikation erfalgreich lbertragen fir falgerds Gerdte:
METATROM 1 [141)

METATROM 2 [142)

METATROM 3 [143)

Abbrechen

7160-9001-521
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8.2.4 Assigning addresses to DPNET devices (network installation)

Attention!

Please follow the relevant user manual for the device when installing
DPNET equipment! (eg for METATRON)

When installing the system, each device will be allocated an address in the network
and the devices will be configured.

First of all, install all the DPNET devices within an installation.

Installation procedure

e To help ensure that the correct order is followed when sending the individual
Service Pins, the installation tree can be printed out with “File -> Print”.

e In the menu ,Network installation”, select
- ,Address specification->All” for installation of all of the devices in the tree.

“Address specification->Individual” for installation of an individual
selected device

e Send the Service Pin from each device to DP one after the other (in the order
of the installation tree).

Gerdteinstallation _)'_(_!

Bitte dilicken Sie den Service Pin; Metaton 4 [2/2]

Abbrechen

Attention!

Make sure that you send the Service Pin for the right device as
otherwise this will cause malfunctions in network communications.

e After sending the Service PIN, wait for the ,wink” from the device (e.g.
METATRON flashes 3 times).

If this does not happen, then check progress on the PC.

e Continue with the next device until all the devices have been installed.
After installing the last device, a corresponding message will appear in
DPNETInstall.

x
Bitte Service-Fin diucken: Metatron 1 [147]

Gerat Uberspringenl | Abbrachen I Reihe Lberspringen

e Scan the network

7160-9007-521
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8.2.5 Setting up DPNET Interface

The DP computer must be equipped with a DPNET interface in order to enable the
DP computer and the DPNET components to communicate with each other.

The installed interface is to be set up in DPNETInstall under “Network
installation->Interface Set-up”.
In the case of XLON-PCI, the following screen appears:

DPMetInterface |

— DPMetInterface
{%" =lon PC Interface N, |E| vI

" won USB

™ PCLTA-20

Abbrechen |

Possible errors

Error message Cause Remedy
“Unable to open LONTalk DPNET interface or driver Check installation
Adapter” missing

7160-90017-521
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|8.3 Equipment information
Here, you can call up information on a device selected or call up actions.
There are two ways to select the device:
e By clicking on the Service Pin
e By making a selection in the tree
Status query

Display of status information on the Neuron
processor (important for fault diagnosis).

DPNetInstall |

TransTimeouts: 2

- “Node State” have the value f\i) KmitErrs: O

“Configured/Online”
If the entry does not match, a new Neuron
download must be carried out.

- If any problems occur, note the value of
“ResetCause” and tell the engineer if asked.

Communication table query

Display of the devices with which the device [ T— "

selected can communicate.

Version query

RcwTransFull: 0
LostMsgs: O
MissediMsgs: 0

ResetCalise: External (Ox12)
MNodestate; Confiquredionling

Verhurn; 9
EtrarLog: Ma Error
MaodelMun: 11

Display of version information on the device

(including the current version of software and
hardware).

“Host ID”, “Host Software Version” and “Boot
Version” only have an entry for devices with host
software (see figure in the METATRON
example).

™ X
" Communication Table from DP
% Tommurnication Table from DPMet
Subnet Hode
101 1
104 1
103 1
102 1
0 0
0 0
1 3
Ok
xl
Fenmung-Host: i P
SaftwareVersionHaost 1.07
BootYersion, 1.05
Fenmung-Meunan: P21
SoftwareVersion-Neuror: 35
Hardwrare-Yersion; WP .00

56
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Configuration data query

The interactive window displays the configuration data on the device selected

Gerite-Parameter (Konfigurationsdaten)

" DF Konfigurationsdaten

o' DPMet Korfigurationsdaten

Torgtewerung 1 (102411
Mr. Wiert
0&
30

a

20
20
20

0

10

]

0

o0 0@ O P

—_

Bezchreibung

Zeit biz Schiiefen nach Lichttaster [sec)
Zeit biz Offnen nach Offnen Boxeingana [zecl
Anzahl Responder/Rescounter - Stellen
Zeit biz Betatigen des DipWentil: [z2c]
Spridhdausr DipYentil [zec)

Abzchalten nach Standby-Signal [zec]
Gangubenmachung irstalliert

Zeit Gang belegt [sec)

Alarmdauer [zec)

Eirgarg mit Tienyeiche

Signals

“Wink" triggers the wink command at the selected device. This command is carried

out differently by the different devices.

Device

Signal command

METATRON P21/521

LEDs will flash 3 times

Gate control

Gate rattles (only when vacuum is
connected)

Box control unit

Gate rattles (only when vacuum is
connected)

Standby module

No action

Setting of configuration parameters

Transfer of configuration data to the device selected without having to carry out

installation.

This action can only be used for installed devices.

7160-90017-521
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19 Starting up DAIRYPLAN

Once DAIRYPLAN has been installed on the computer, the necessary settings have
to be made.

e Start DAIRYPLAN.

e You may be asked for a “software key”.
For more detailed information on this subject, please see

(L7 Section DAIRYPLAN licensing
- Totemporarily pass over entering the second software key, click on “Close”.

- The question about the 2nd software key appears whenever DAIRYPLAN
programs or functions are started or data have been entered.

- Enter the second software key before the expiry date.

[]?> Note!

If the 2nd software key has not been entered at the right time,
DAIRYPLAN programs for evaluating data and entering data will be
blocked. Process control continues to work (feeding and milking
parlour control continue to work).

Base Setting

When DAIRYPLAN is installed on the computer, the basic settings are required to
control the connected peripherals.

Make or check the following settings:
e The settings in DPSetup
e The settings for the feeding and calving system (if installed)
e The settings for milk metering control (if installed)
e Settings for DPNET components (if present).
e Minimum input of animal records for functional test
e Setting up the Multi Port Card

To ensure that DAIRYPLAN starts automatically when the PC is switched on, there
must be a link from DPProcessControl in the Windows Autostart directory.

7160-9001-521
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[9.1 Settings in DPSetup |

9.1.1 Setting up the Multi Port Card with DPSetup

A few settings are required so that DAIRYPLAN can operate with the Multi Port
Card.
These are in the “Devices -> Select interface” dialogue box.

Schnittstelle auswahlen

¥ ‘COM Ports nutzen [Mulbport [nterfaceE

Belegung bdaw. dinzahl Belegung b &z, dnzahl
F.artenkanale Gierate auf K.artenkanale Gerate auf
diesen Kanal diezen Kanal
COM | COM3 18
COM2 | COMI0 |15
COM3 | COM1 |1l3
COM4 | COM12 |15
COMS |15 COM13 |15
COME |15 COM14 |15
COM7 [6 COM15 B
COME |18 COMIE |1E

Lzade Standardeinstellungsh | Ok I Abbrechen I Help I

e Activate “ Use COM ports”.

[]?> Note!

When connecting with the Multi Port Card the designations “COM  x”
should be used, and when connecting with a Dual Port Card, the
designations “Dual Port Card x” should be used.

e You need to enter the number of devices (usually 16) for the channels used by
DAIRYPLAN (eg COMS5 ... COMS).

Attention!
All previous channels (e.g. COMT1 .... COM4) should be set to “0”.

The “Wizard” goes through the main settings and is started as follows:
e In DPSetup, select “Wizard->Start”.

WESTFALIA DAIRYPLAN [ 221 e R

SR Anslvse Tierdaten Aufucht Ftemn Reproduklion Gesundheit Somieren Malken Anlage Dateraustausch [ ]
| 9% Datensicherung (DPBackip)
Einstellungen :ﬁﬂ.\\gemgm

| (21 suswertungsprogramme | €8 DFMobil (DPMokilSetup)
| & Herdenstatistik

(3] Dateneingabe

[+ Systemprogramme

(%] Datenbankprogramme
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9.2  Feed System Test |

Note!

If no feeder system is installed, pass on to the section headed “Testing
METATRON".

A test should be carried out to check whether all of the feed stations and calf
feeders connected have the correct electrical and logical connection to the PC or
DAIRYPLAN.

If a connection is present carry out a “Feed Motor Test”.

Checking the connection

e In Windows ”“Start - Programs - DAIRYPLAN” call up “Process Control
(DPProcessControl)”.
Alternatively, in the DAIRYPLAN main menu click on ”S-> System programs->
Process control (DPProcessControl)”.

A process control window appears with the following tool bar (see also section
on “DAIRYPLAN Programs /| DPProcessControl”).

2 DPProcessControl _ o] x| I
_n Datei Bearbeten Aklionen  Ansicht  Fenster  Hille =] x|

B e A

< W o &P

Verbimdungstast Futtal

Boax Dieses Tier Woriges Tier
Hc Fehler Fatter Suarane Tier Besponder Pation ERest Werfigbar [Tiec Fefressen
1 Ll.Futter o L] L] o_0o0m 0.000 a.o00 o o.000
]
2.Fukter 0 0000 0000 0.000 0.000
z L.Futkzr 0 ] [ 00000 0000 0.000 0 0.000
0
2.Futter o o_0o0m 0.000 a.o00 o.000
2 Aus Ll.Futter o L] L] o_0o0m 0.000 a.o00 o o.000 LI
Fuktersystemn Testanzsigs l_ IW o

e The button opposite calls up the status display for feed stations and
feeders. If there is a communication error with the peripheral, this J
is shown in the “Error” column.

o

e Possible error messages in the “Error” column:

OFF No response from the transceiver

RESPOND? Unknown responder number

XM EOF Transmission error (end of file not received)

XM ECHO Transmission error (character transmitted not the same as the one sent)

XM TIME Transmission error (the unit is not responding within the permitted time)

XM EXTRA Transmission error (“unusual” data)

DUP ADDR Address possibly duplicated

NO PORT Dual port card not functioning properly

BAD No reply from the motors

[]?> Note!

Occasional error messages (especially after the system has been restarted)
are not serious. If these faults occur frequently check the wiring. The
faults may also be caused by defects in the electrical components.

7160-9001-521
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Testing the Feeder Motors

e From the “Actions” menu, select “Test Feed Motor”, or click on the

button opposite with the info text “Test Feed Motor”. ?l

For more detailed information on this subject, please see
7160-90. . -520 DAIRYPLAN operating instructions

e Select the required feed stations in the following window. Then click on “Start

Motor Test”.

e This also checks the weight of the feed portion.

If the function test has been successful for all feeder motors and stations, you can
start working with the feeding system.

9.3  Testing METATRON |

Note!

If you do not have any METATRON milk meters, please continue with the
Section entitled "Minimum DAIRYPLAN Settings”.

Check whether all of the connected METATRON devices have a electrical and
logical connection to the PC and to DAIRYPLAN.

If a link exists, then individual METATRON units can be switched on and off via the
master switch in order to check the addressing of the METATRON units.
(Does not apply for METATRON P21/521)

Checking the connection

e From the DAIRYPLAN menu, click on “S-> System Programs-> Process Control

(DPProcessControl)”.
e A process control window appears with the following tool bar.
2 DPProcessControl O] ]
_n Datei Bearbeiten  Akbanen  Ansicht  Fenster  Hilfe =] x|
EASB 8 7|< ¢ |%|q 40|
Miel kstand Mo mmurnikatior M E TATRON r
MET AT RON Dieme= Tiex Voriges Tier
Tiar Pe=pondar Fr TFahleax Tiar Ba=p_ Daner Milch
1 3pil 1] 1] 1] o 1] o:on o.on
z o o o o o 0:on 0.an0
2z o o o o o 0:on 0.an0
3 o o o o o 0:on 0.an0
13 1] 1] 1] o 1] o:on o.on o
& Ens 1] 1] 1] o 1] o:on o.on
T Bu= o o o o o 0:on 0.an0 LI
METATROMN Testanzeige LIk o

e Click on the symbol with info text “"METATRON" to list the METATRON

control devices. D
The communication status between the peripherals and DAIRYPLAN is

shown in the “Error” column. If everything is operating correctly, the

“Error” column will be empty, otherwise an error message or the status
of the device will be shown.

Ifno equipmentis displayed you must check to see if the system is set to measure
milk yield.

If milking has taken place without the computer being connected remove the
bridge from the “DS” data line to ”-” on the METATRON coupler card.

7160-90017-521
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e Switch on the vacuum pump.
If some or all units display “OFF” for more than three minutes, proceed as
described in the Section entitled "DAIRYPLAN Programs”; "DPPORT - Help
Program”.

Note!

There is no fault if METATRON displays “OFF” when the vacuum pump is
not operating.

Testing a METATRON unit

Note!
The test described does not apply to METATRON P21/521!

The previous test described how to check the electrical connection of the
METATRON devices. For example, if two METATRON devices are mixed up because
the addresses are wrong, the following “check” can be performed. This checks the
logical connection.

e Switch some of the METATRON units off at the main switch.

e Inthe “Error” column, it must be possible to see the changes made on the right

devices.

If not set the address correctly.
e This completes the check on the METATRON units.

Possible error messages in the ”"Error” column:

ID Off No response from ID (S/E switched off?)

COW# ? Unknown animal ID received

MATCH ? Animal ID and milk quantity do not match

REPEAT? Animal has already been milked at another milking place
11112 Unknown responder number 1111

XM EOF Transmission error (end of file not received)

XM ECHO Z)’;a:;rerllqii)sion error (character transmitted not the same as the
XM TIME Z)’rei?;l(z:gc;?megor (the unit is not responding within the
XM EXTRA | Transmission error (unusual data)

DUP ADDR | Address may have been duplicated

NO PORT Dual-Port card is not working correctly

ID ADDR ID address may have been duplicated

ID PORT? Dual-Port card is not working correctly for ID

MAN ENTR | Manual milk entries not permitted on METATRON

62
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|9.4  Feed Settings |

The following settings should be made in order to guarantee correct feeding.

9.4.1 Device-specific set-up for feeding

In the menu ”"Device management - Feed station set-up” first of all specify the
number of stations connected (feed concentrate and drinking stations).

Angaben uber die Futterstationen I

Geben Sie die Gezamtanzahl der Kraftfukterstationen

IF vI

Einstellung Futterstationen

Bbbrechen I Ok |

With the "Feed transceiver set-up” button, the following settings can be made for
each station and each type of feed:

e Portion weight

e Pause time

e type of feed allocated
e type of feed for silo

Einstellung Futterbox 2  dairyplan 5 Kuhfutterbox I
— Motar 1 — Mator 2
Partionzgewicht I Partiohsgewicht I o110
Pauzenzeit I 20 Pauzenzeit I 20
Mummer der Futtersorte Murnmer der Futtersorte
Auswahl | Auzwahl | . -
Einstellun I |1 .Futter Einstellun I Ikeme Futterzorte gewah
Futtersorte fiir Silo Fuktersorte fiir Silo
Auswahl : — Auzwahl : —
EFEEIn Ikeme Futtersorte gewah EEEIn Ikeme Futtersorte gewsah
— Motor 3 = fealitar Fr ez}
Partionzgewicht I 0.040 KRalErienertl 1]
Pausenzeit [10 ltarienert 2 o
Mummer der Futtersorte IRalEniemert 2 I ]
Auswahl . I
m |3.Futter IRalEnienert 4 o
Futterzorte fiir Silo — Allgemein
Auzwahl | ﬁ Futterboxentyp:
Einstellun: i (U iEas g Boxentyp Sndern | I dairyplan 5 Kuhfutterbox
S/E Programmyersion IEW’S3FWS.-100[4
| = | | | Hirweis : Es stehen insgesamt 4 Motoren
:;4 A‘ P = zur Yerfligung. Abbrechen | Ok I

Click on the “Change unit type” button to specify the type of feed station.
With the “Set-up” button, settings can be entered for the types of feed.

If feed stations with more than three types of feed are connected to
DAIRYPLAN, the settings are entered on a second page (click on the button
opposite. —
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9.4.2 Feed stations with more than 3 types of feed

If feed stations with more than 3 types of feed are connected to DAIRYPLAN,

DAIRYPLAN detects this and displays 4 or 6 feeder motors for those feed stations.
Go through the following steps:

e Allocate a type of feed to the additional feeder motors - one which has not
been used for the other motors or feeder box types.

e Set the type of feed as required in “Feed Type and Bins”.

e The feed reports used by the client must be amended using the corresponding
feed types

[]?> Note!

For processing reports, please see DAIRYPLAN Operating Instructions,
Section "DAIRYPLAN Programs” - "DPList - The list generator”.

9.4.3 Responder settings

Menu "Device - Responder and activity setup”
Responder- und Aktivitats Einstellung E |

—Anzahl Responder/Rescounter - Stellen

4 -stelflig (120 KHz ID)

i= 0 el flekzten 8 Shellen von SO0}

15 -stellig [vollstandige 150 1D)

— &ktreitat

[v¥ RESCOLMTER gingesetzt?

Ok I Abbrechen Hilte

The following types of responder can be set:
e 4-figure

4-figure X-responder and RESCOUNTER (amplitude and phase modulated)
e 8-figure

15-figure I1SO responders (only the last 8 figures are used).
e 15-figure

15-figure I1SO responders (all 15 figures are used).

Note!

8 and 15 figure responder types require an ISO transceiver with an ISO
program chip!
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9.4.4 System-specific settings for feeding

”System - feed schedule and general setup” menu

Allgemeine Futterungsteuerung Ed |

Test Portion  Futterzeiten | Sonstiges |

— Startzeitpunkt — Letzter Futterstart

Startzeitpunkt des Futterzykius
SR Datum letzter Futterstart |13.11_DE
: Uhrzeit letzter Futterstart I'I =02

Startzeit fur Futterzyklus [24 5td.] Letzte Futtedkalkulation |1 211.02

andern |

— Stoppzeiten

Fiittern blockieren ab:

IIJ:DD ID:[ID |u:uu |D:nn
|u;00 |D:IIID |u;00 |0;uu

Flithern wigder starten ab:

dbbrechen | Ulgernehmenl Hilte

The system-specific settings include specifications for the delivery of a test portion,
feed times, settings for scanning and report files.

On the “Feeding times” record card the ”"Feed cycle start time” can be adapted to
the conditions of the farm.
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9.4.5 Determining and entering the portion weight for a type of feed

Allgemeine Futterungsteuerung Ed |

Test Portion |Futlerzeilen| Sonstiges |

— Test Responder

Testrezpondemnummer
" Testportionsn wor allen Matoren

{* Testportion van einzelnen Mator

1391

Motarmummer zum Testen |1

Ol I dbbrechen Ubemehmen Hilte

In the program “DPSetup”, Menu “System - General feeding control”, a test
responder should first of all be set on the “Test Portion” index card to determine
the weight of the portion (“1991” in the example above) and a motor number
entered (motor numbers 1 to 3 are available).

=

Note!

If motor number “0” is entered, all feed types for a station are given out
one after another. To do this, after one feed type has been delivered the
responder must be removed from the identification field for at least 20
seconds (transceiver shows status “10” again), before a test delivery of the
next type of feed can be triggered.

A

Attention!

The test responder must never be attached to an animal because that
animal would then receive unlimited feed!

Trigger the delivery of feed with the test responder (10 portions are delivered).

Because the amount of feed delivered corresponds to 10 portions, 10% of the
weight determined should be entered as the portion weight.

To end the test delivery, another responder must be brought into the identification
field after the 10 portions have been delivered.

=

Note!

If another responder is brought into the identification field during the
delivery of feed, this will abort the calibration process.

A

Attention!

This procedure should be carried out for every type of feed, every feed
station and for every new delivery of feed!
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Menu headed ”Device - Feed Station Setup - Feed Transceiver Setup”

Einstellung Futterbox 2  dairyplan 5 Kuhfutterbox

Enter weight of portion.
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9.5  Milking parlour | METATRON Settings |

Group and AUTOTANDEM milking parlours in particular, work well with the basic
settings.

In addition to the main settings which have been made using the Wizard, other
information on the milking parlour can also be given.

The fine settings can be made in the DAIRYPLAN menu ”S-> Settings-> General
(DPSetup)-> Devices-> Milking parlour/METATRON".

When this menu point is selected, the following
dlalogue box appears: ~ Einstelung Melkstand
Anzanl METATRON 0 B
| [ Einstellung METATRI UN'I
Kontrolle METATRON Einstellung vom PC v
Typ Melkstanderkennung
[21. 1D mit DPNET |
Anzahl Melkstandreihen EZ :I'
Efnstelling Melkstandrehen |
Futtersarte fiil METATRON O
ok Abbrechen | Hire |

Setting METATRON
This function can be used to specify specific settings required for the METATRON
terminals.
Einstellung METATRON - 1-5 I
Fulzation I BACKFLUSH | Elockiere | Sonderfunktionen | Anzeige P21 I Reinigung I
Algemein | Fliteung | Kick Off | Meken1 | Meken2 | Machmelkautomati
E inztellung Melkstandreihen |1
Type METATROM M
Programmverzion RAP 1,20
Pragramrn Check-S umme o2

DPNET _ [BoctProgiers  WMP112

Komponentenversior  |H/Progiers e
MeuronSiwRey
MNeuronHwHey
NewronlD

DPMET Subnet: Gerdte Adresse Il

| | Auswani | Ok | Abbrechen | Hite |

e the specifications can be entered for individual or several METATRON devices
(e.g. 1-5).

e Whenever the METATRON devices change to “Rinse”, DAIRYPLAN checks
whether the setting for the METATRON devices in the milking parlour match
the specifications.

e If DAIRYPLAN finds differences in the milking parlour the values stored in
DAIRYPLAN are loaded onto the METATRON devices.
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Setting milking parlour rows

Melkstand Installation - 1

—&llgemein

[won M elkstandinstallation' ]

DPKET Melkstandyp
rechte Rethe / im Uhrzeigersinn
Meuer Melkstand

BPNET ID Typ

S/E Programmmyersion

]|
METATROM auf dieser Reihe IE Herbindungstyp
[wan "Melkstandinstallation') andem |
|0 Modus fiir diese Melkstandreihe |21 ID it DPMET LI

I 1; Gruppenmelkstand kanw.duzgan LI

v
r

[1: DPNET Durchiauf 1D =]

—

— Ralibrigrwerte fiir die Erkennung

— Pausenzeit fiir Erlkennung

1|DDEID 2|DDDD 3|nnuu 4||Jut|n

o Py o

r— Feset - Plan fur METATRON

ID - l Zeitplan |

—Wakuurnztunden seit Start

Stundern n217

—Wakuurn Ansbus Zeit
won 1702 42 1516
ik 19:39 812 15:48

Gtartdakurn 31.01.98

Aktualisisrsn |

Auzwahl I_HJ @I

0k | abbrechen |

Hite |

This function is not needed with standard parlours. If special calibration values are
necessary, enter them at this point. In the case of Trigon milking parlours, the
“Metatron on side 1,2,3” must be specified at this point.
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Starting up DAIRYPLAN

19.6 Minimum entry of animal records (for functional test)
Once the PCs and peripherals have been connected, the animal data have to be
entered.
To check that the system is operating between three and ten animals have to be
entered, depending on the size of the installation.
For more detailed information on this subject, please see
(L7 7160-90. . -520 DAIRYPLAN Operation
9.6.1 Entering Information on Livestock
Enter new animals through “DPMenu -> Animal data -> Manage animals -
>Record”:
@DPMenue !B
Westfali
WESTFALIA DAIRYPLAN (CC =1 o
E Analyse Tiemarén' Aufzucht Fiftern Reproduktion Gesundheit Sorieren Melken Anlage Datenaustausch ﬁ
i@ BB Anlegen
%{, 1 Losohii
DaleHEi| E Tier Nr. andem
E Responder Nr. eingeben/&ndern
Dy =
Bl Mcuer Tierdatensatz | :
Wichtige &
"J-—'fr?‘gm — Firsyabsufir 111
Tierilbe Meue Tiermumner singeben ||
R espondemummer
@ Ohrnark ennumirmer I
Lei
— I-”‘I N ame I
E it : e
S Liste | (T | Water
. utter I
= ehrere Tiere
Zugangsdaturm I]EI.H.EIE
X | Qe | Eruppenummer IEl
ot = Geburtzdatum I
- INi al BT | B REEE T EE
it rehmer Laktationshunmer IEI
Bl : Letztes Kalbedatum I
L) Fa= | = = == s | )
ZefZEn Letztes Bezamungsdatum I
Letzter I
[T DPSingle nach beenden aufrufen Letstes Trockenstelldatum |
Ok Abbrechen Hilfe Status Code IDHNE "i
To run the installation the following minimum entries are absolutely essential:
for cows | goats | sheep for young animals
Animal ID Animal ID
Responder number Group ID number
Group ID number Date of birth
Date of birth
Last birth date
Lactation number
7160-9007-521
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Automatic Report Printing

I DpProcessControl, in the men

“Actions-> autom. functions” exact
information must be given on the

! | Zuletzt von DP ausgetihite autom. Funkhion
functions which are to be performed

1061530 Check Mizzed Cowz1 [[Too ﬂ

automatically (see “Installation Late) 0 Sec]

protocol”). 10:15:30 Feed Calculations [Win) [0

For more information press “F1”. Secl

0 ore ormation press 130202 Feed Reset [0 Sec]
180202 Check Mizzed Cows 1 [[Too
Late] 0 Sec)
180202 Feed Calculations [Win) [0
Sec] | .
15:20:00 DPHerdStat [1 Sec) =

— Einztellung autorn. Funktiohsn

Futer | Mich |

aultom. Listen | [ atenszichering |

ul

e Feed-> Feed times:
Enter a suitable start time for the feeding cycle.

o Milk:
Enter the milking times. The actual milking times must be within the times set.

e Autom. reports:
Select or enter reports which are to be printed automatically at specific times.

Note!

Dairy Plan offers a large number of lists in the “dairypln - FactOrig -
de” directory.

Examples of monitoring lists:

Report name Recommended printing Purpose
time

Feed monitoring after start of feed Feed monitoring
Observe daily  weekly Heat monitoring
Heifer about to calve weekly Calving overview
Animals due to calve weekly Calving overview
Vet action weekly scheduled vet action
Unidentified animals in the Post milking Animals with no milk quantity
milking parlour
Conductivity value and milk Post milking Conductivity value and milk
alarm monitoring
Activity monitoring 2 daily Activity monitoring
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e Back-up:
Enter the time and filename
(including path) for the scheduled file

Einstellungen DPBackup

Eimztellung autaratizehe Sicherung I

—Awutomat. Sichenngsdatum
baCk_ Up. [wenn D atum eingetragen, werden
The da ta iS th en sa ved at the tlme automnatische Sichersnaen erstellkl

L Daturn Zeit
specified every day.
P yaay. |19.11.02 11:02

— Dateiname [incl. Pfadangabe)

IC:\D FPEackupdaivbackup.dpb

Mehifache D atensichenungen
M aufbewahren

Abbrechen [bemetimen Hilfe
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|70  DAIRYPLAN Programs |

This section describes the areas in which some of the DAIRYPLAN programs can be
used, and how to use them.

[10.1  General remarks |

Help
Press "F1” to get help at many points in DAIRYPLAN.

Enter Date | Time
e current date/time: enter ”-” or "+” and leave the field.

e Retrospective date: enter “-3” (the date three days ago).
e Of course the date can also be written out.

e Other possibilities:
- Enter day: current monthlyear is added automatically,
- Enter day and month: current year is added automatically.

Data input

To get into the field to be edited, press the Tab key (Backspace with
"SHIFT”-"TAB"),

Pressing the "Enter” key usually saves the data entered and completes the function.

A Attention!
The data stored in DAIRYPLAN are an extremely important and practically
irreplaceable asset!
For this reason please back up all information every day by placing it on
an external data carrier (e.qg. floppy disk). It is best to use two disks and
alternate.
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|10.2 DPDataTest - Test Program

What DPDataTest Does

“"DPDataTest” is a test and repair program for DAIRYPLAN data records.
The program analyzes the data record for errors and warnings in each individual
animal record. All messages can be printed out.

Carrying out DPDataTest

e Call up the program with “S-> System programs-> Databank test (DPDataTest)”

e In the "File” menu, call up “Test databank” to activate the data test
(alternatively, click on the button shown).

‘@DPDalaTesl M=l E3
& Datei Bearbeiten Ansicht Fenster Hile =181x%|
=IO RIEE B

[Datensatzanalyse: WESTFALIA DEMO =l

Summe der Tierdatensédtze: 34, alle in Gebrauch
eingesetzte Version 5.090 seit 5.04.02

Letzte CD - Version: 5.099.00 installiert am 5.04.02
Datenbank - Datei Typ 5.100 Compatibel
[DPDataTest VYersion 5.099.05, genutzte DPFDLL 05]
NPVYerzinn ini 'R N99 NR"

e The customer data record is opened and analyzed for
errors/warnings. "R..
If the program finds any errors or warnings, the menu point “Repair
file-data record” can be called (alternatively, click on the button
shown).

The screen will also show whether it has been possible to remove the
errors successfully.

Database Repair Setup I

~ Temorare D ateieh

DARYPLAN nutet verschiedens bempordre D ateien um 0k
Diateneintrage zu koordimeren und zu ubenwachen. Diese _
Optian NICHT nutzen solanges nock anders DF - Progranmme
geoffnet wind [auch DPFroceszControl) &bbrachan |

-~ D efekbe Feldeintrags: reparisnet
. falzche 'Stnngs' sind Testfelder, deren Feldinhalt zu lang izt und das nachzte
[V fakche Stings  patenfeld iiberschreibt, oder Felder mit ungiitigen Zeichen. Diese Option entfemt
der Inkalt aller betroffenen Felder volltandig

falzche 'float Falsche ' Float' Werte konnen in Zahlenfeldem auftreten. Im Mormalfall handelt es
i Werte sich um kleine. nicht sichtbare Dezimalwerte, die won einem Fehler ohne Bezug
werurzacht wurden. Diese Option setzt fehlerhafte Felder auf Mull

 Dal - Falzzhe Datumssintiage erscheine meistens aus demdabn 1367, ader sind rnickt
AILMSENIALE  gichthar, Falsche Zeteintidge haben wWerte iiber 23:58, oder sind nicht sichtbar,
v Zeitangaben Mit diezer Optior weerden solche Eintrage vollstandig entfemt.

~ Fepariiae Tabelen
& Defekte Indexe loschen D&z Programm lozcht Falzche D atums- und Zeitangaben vollstandig
¢ Defektes Datum lgeckhen  aus den entsprechenden Tabelleneintidgen. Solche Eintrdge konnen
' (1 D e st jedoch haufig manuel komgiert werden.

W ltsche zukiinftiges Datum

Dieze Option sotier; automatizeh die Tabellen new, unabhdngig
[~ Tabellen neu sortisren davon ob indexierte Werte gelozcht wuarden. MICHT nutzen, wenn Sie
die emtzprechender Datum- ZaitsintSas manuell Sndern wolles.

= Cie Qption regenenert den ndex der T abellerinhalte in der D ate
W Indexs emaush DpDairy. da. Dadurch kiknen ' Zuordhungsfebler behoben werdes,
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Notes on the "File-> Repair data record” menu

In the “DataBase Repair Setup” dialogue box, select which errors are to be
corrected. In the standard set-up, all possibilities such as string errors, data type
errors, date and time information are selected.

[]?> Note!

To correct a table error, select all 3 options, “Delete incorrect indices,
Delete incorrect data, Delete incorrect date/time” one after the otherand
call up the respective repair tool.

Keep repeating the “Check and Repair Database” procedure until no more errors
are displayed.

Cause of Error when Starting DPDataTest:

less than 200 megabytes of space on the hard disk

temporarily remove all programs from the “AutoStart” group

please note the exact error message
the DAIRYPLAN file “DPNET.DAT” has been deleted

7160-90017-521
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[10.3 DPDataConfig

When to use "DPDataConfig”

e To maintain the DAIRYPLAN data records

e To change the size of the tables for the METATRON vet action data for an
animal in DAIRYPLAN.

e To optimize data access (defragmentation)

e If various tables (e.g. "Measurements” or "Weekly Resources”) are to be
extended for certain applications.

Function

The program copies all data from DAIRYPLAN into new files on the hard disk. The
new file is sorted according to animal ID; all deletions and file errors are eliminated.

“DPDataConfig” checks the settings made for the hardware and the various graphs
ifentries have also been made in different tables (e.g. “Measurements” or “Weekly
average”). The tables are expanded to take additional data.

Most data record settings are made automatically.

Executing the Program
e End all DAIRYPLAN programs (see also "Appendix”).
e Start "DPDataConfig” by double clicking on it in “Windows Explorer”
e End the program with the OK button.
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DAIRYPLAN Programs
|10.4  DPPort - Help Program |
32 DPPoit (O] x]
Fie Opions Yew Help
&| =[ox| =[=|¢%]
C OO0 OCOC®e 00000000 oo
COM1 1200
COMS 1200 Feed/ID 1 2
COMB6 1200 Metatrons 1T 2 3 4
COM7 1200 Feed/ID 1
COM8 1200
For Help, press F1 | [NUM | o

When to use DPPort

e to check the electrical wiring between the Dual or Multi-Port Card and the
peripherals.

e to check the dual port card addresses

e when a check has to be made to ensure that the peripheral units are responding
correctly

e to check whether the peripherals are connected to the right dual-port channel
(1A, 2A etc.) / COM-Port.

Note!
DPPort works independently of any DAIRYPLAN settings.

Function

It displays an interface connection test.
All channels are tested simultaneously. The cable connections can be put together
and taken apart while the program is running so that the results can be seen.

7160-90017-521
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Executing the Program

To start the program, double click on “DPPort” in Windows Explorer

The screen shows information on the connection (COM-Port, channel), Baud
rate, device type and number.

If various peripherals are connected the number of devices will be shown.
Example:

- METATRON COM 6 with 4 connected devices
- Feed box COM 5 with 2 feed stations.

If the screen shows “PORT NOT FOUND” and the card has actually been
installed, then check the plug-in code or replace the card.

Plug a dual port test connector (7162-9047-080) into any available output to
test the dual port card channels. If no "TESTPLUG” (“TESTCONNECTOR”) is
displayed then you must check the plug connections of the card or the card
must be replaced.

Connect the cable to the power supply for the peripheral. Each address from
0 to 15 is tested separately. Note that the first feed station (or the first milk
meter) has the address 0. If some units reply with the wrong address check the
connections and feed stations.

7161-90. . -520 DAIRYPLAN Operation

[]?> Note!

Device 1 has the address 0, device 2 has the address 1, etc.
Device numbers: 1 - 16, Address numbers: 0 - 15

If none of the connected units replies then disconnect all units (except the first)
from the power supply. Check all wiring and fuses carefully until the first units
works correctly.

Once the first unit is working, wire up the additional units one by one. Asingle
faulty unit can affect the entire system of communication of the entire channel.
Replace any defective units.

78
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[10.5 DPAlarm

General remarks

Function

Different programs send an alarm signal to DPAlarm as the central alarm
administration if a problem occurs (e.qg. problem with a feed box). The program
manages the alarms raised, shows a current alarm in a clearly visible window and
may also give an acoustic alarm. This will need a sound card with associated
loudspeaker boxes.

It is also possible to call up other programs via an alarm (e.q. pager - radio call -
program)

[]?> Note!

In Windows 98 it is not possible to use the PC’s internal loudspeaker.
Acousticsignals can only be output through a sound card with connected
loudspeakers..

If a message relating to a malfunction has been sent to “DPAlarm”, the pre-alarm
time is first to be activated. This can be set by the individual user (see "Set-up”).
In the case of a one-off short malfunction - e.q. brief cut in power supply to feeder
box), an unnecessary alarm can be avoided in this way. Only if the problem is still
present when the pre-alarm time expires will the actual alarm be triggered.

The automatic milking system “Leonardo” can be considered an exception here.
In this case the alarm is always recorded and triggered.

If an alarm is sent several times without being acknowledged in the interim, it is
only displayed once.

1 4 1 1 | Optical signal:
Flashes when there is an
alarm signal

\ \ Details:

\ ‘ 0:57 Click here to activate the
set-up functions of the

alarm program.

N

‘ QAUITTIEREN |

\\ 3 | Acknowledge
07/15/99 (35742 _F uiterstation aus 1 Clicking here clears an
alarm.

4 | Pre-alarm time

. 5 | OK:
Ll LI Close the program with

IIOK ll.

Note!

If the program is terminated without acknowledging a current alarm the
corresponding alarm signal will still be given.
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DPAlarm “DETAILS"

@} DPAlarm !El 1

Alarms:
Only the current alarm will be
indicated

Setting:
Call up set-up dialog

GUITTIEREN |

3599 Futterstation aus 1 2

Inactive

Alarms already confirmed are
indicated. Double-clicking on
the relevant alarm gives
additional information on the
alarm.

Settings

O dlame (F dnaklive O Alle
Details. . : / ............ \{ 4 | Comment:
Enghune) K“"’"’,?”tarl o J Any comments can be added
A B A 5 |All
1 2/ 3/ "1 \5 6 All alarms and actions (e.g. last
update) are shown
6 | Test:
Call up flashing and alarm
display on the computer
“Programs”

Alarms are reported to the DP alarm program in three different levels, the priority
of which is determined by the sending program and cannot be influenced.

Clicking on the appropriate checkbox calls up the program and the name of the

program can then be entered.

If there are several current alarms waiting, the one with the highest priority will be

sent first.

DPAlarm Setup

Programme | Ton | Zeit | Alarm Liste ]

DPAlarm kann nach Sblauf der Voralamzet fir dis sinzelnen Alammsufen

untarzchiedliche Programme aufrufen [ohne Hakern wird der Programmaufof nicht

auzgefih]

Blarmbyp

Pragranarmaufruf (mit Plad):

]|

Test

™ Mitel |

Test

[ Hach I
[ wiedsrhalzen

[ Maote Each Alamn / Jeden dlam melden

Test

£l ]z

Ok | Abbrechen |

Hilfe

If “Repeat” is activated, the pre-alarm time always starts again and the programs

entered are called up each time it ends.
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“Sound”

If the “Special” function is selected any *.wav (Windows-SoundFile) can be
activated in the event of an alarm.

This requires the entering of the corresponding file name with the appropriate
path specification.

DPAlarm Setup E3 I

Frogramme 100 |EEit I.-’-'-.Iarm Listel

Wenn [hr P lber eine Soundkarte verfiigt, kann DP&larm ein
akustizches Signal nach einem Alarm auslozen.

—tlarm Taon

i Keiner
 Standard Windows

%) S peziell =iy -Datei |C:hDaivplntalarm.way Test I

Abbrechen | Hilfe

[]?> Note!

With Windows 95/98 it is not possible to use the PC’s internal loudspeaker.
Acoustic signals can only be sent via a soundcard and connected
loudspeakers

“Time”
In this menu it is possible

e to enter the pre-alarm time.

e Number of days after which old alarms can be cancelled.
“Alarm List”

Using this function it is possible to show, copy or export into a file all saved alarms
in accordance with certain selection criteria

If only certain types of alarm
are to be displayed, enter the ogarme | Ton | zet e Lise |
type of alarm here (e.qg. i — :
"FeedOff”).
Then click on “Update”.

Export: With this function the
alarms can be copied into a text

file.
Expart
Hirweis: Sie konnen diesen Text markieret und

kopieren [z.B. mit rechter M austaste] 5«ktualisiered

L FeedOff Futterstatio;l r

i
V' Mittel [M]
¥ Niediig [L]
™ Kommentar

[ Schiiizsel

Ok | Abbrechen | Hife
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|10.6  DPProcessControl
The program “DPProcessControl” controls communication between the connected
peripherals and DAIRYPLAN.
ﬂDPPmcen[ﬁnnlml _|of x| I
_n Datei Bearbeiten Aktionen Ansicht Fenster Hife ==l
i o~
HR 2 81 < «|¥[n 0
Melkstand Kom munikatio -
HETATERON Diema= Tier Uoriges Tier
Tier Fezponder r Fehler Timx Fe=p. Dausr Milch
1 Spul Q n Q o Q Qg [
=4 a 0 a o a Ol ]
2 1] o 1] o 1] o on a.on
3 1] o 1] o 1] o:on a.on
5 L] 0 L] L] L] 00 .00 Ee
[ e 1] o 1] o 1] o on a.on
T Enx 1] o 1] o 1] o:on a.on ;I
METATRON Testanzeige [NUM i
Attention!
Process control stops immediately when the “DPProcessControl”
program ends. Then the animals will not receive any feed or drink and
milk metering and identification will no longer work!
DPProcessControl can only be ended with “File-> End”.
Press “X” to minimize the program window —Tal+
and put it in the task bar. .
olIEETNG 1313
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[10.7  DPBackup |
DPBackup is a program for backing up data.
Note!
Save data regularly and keep in a safe place!
e Data can be backed up on [T P = 3|
diskette and also on other
. W az wollen Sie durchfubren ?
data media.
(See llHelp") & D aten sichem }
¥ Grobe Protokolidatzien speichem Schliehen |
' Zuriickladen alker Datensicherungen Hie |
& | Alles curiickladen Einztellung |
£ L Tier ird Shetemdatem srieklader
— Dietailz Datensicherung
Dizkette
b priifen
Prad\.D ater Mame Diskette
IC:\.D PEackuptdpbackup_021119.dpb _l
Durchzuchen, ]
Beschreibung
IBa-::k.up wom 19.11.2002
Betrizbsname
IWESTFALIA DERO
Datum Zeit Yersion Tiere
[111902 1342|5093 |3 e
« Details on automatic data | |

back-up can be entered in
Settings. When a back-up has

Eimztellung autaratizehe Sicherung I

—Awutomat. Sichenngsdatum

taken place on a SpeCiﬁed [wenn Datum eingetragen, werden
da te the da te iS reset by one automnatische Sichersnaen erstellkl
’
d ay. Daturn Zeit
’ Jra1r02 1103

— Dateiname [incl. Pfadangabe)

IC:\D FPEackupdaivbackup.dpb

Mehifache D atensichenungen
M aufbewahren

Abbrechen [bemetimen Hilfe I

For details on this subject, please see
Lid 7160-90 . . -520 DAIRYPLAN Operation
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Malfunctions and Interference

|11

Malfunctions and Interference

[11.1

Computer System - Hardware

Windows provides facilities for checking the computer system.

Information on the hardware can be called up in Device Manager.

Note!

Alternatively, system properties (Device Manager)can
be called up by pressing this combination of keys.

+ Pausel

Malfunction

Cause

Remedy

Total failure

Power supply problem

Wrong supply voltage being used
Lightning strike
Hardware problem

Check all socket outlets and all cable
connections

Voltage setting
Check the dual port card
Service the unit

Empty screen even though
the system is working (feed
or milk OK or printer
reports)

No power supply to monitor

Not enough brightness or contrast
Loose monitor cable

Defect on the monitor

Defective video adapter card in PC
Faulty PC motherboard

Check plug

Change control settings
Secure cable

Replace monitor.

Change adapter card (see PC Operating
Instructions)

Have the PC serviced

Empty screen - system not
operating, with exception of
light on keyboard and/or
hard disk noises

A faulty adapter card can block all PC
operations

Screen possibly faulty or the problem
(especially after power failure)

Defective PC motherboard or other PC fault

To check - remove all additional cards -
especially the dual port cards, modems and
serial adapter cards. Replace faulty cards

Check monitor

When the unit is switched on the PC would
have to display the memory test otherwise it is
a major hardware problem

Service the unit

The computer does not start
DAIRYPLAN

Floppy disk sticking in drive

DAIRYPLAN has not been set up for automatic
start (another program always appears)

Windows 98 start files have been deleted from
the hard disk (shown by “Command not found”
or “Non-System Disk” or another system error
message)

Dual port card either faulty or missing
Wrong address for dual port card
Hard disk fault

Remove floppy disk and start again from the
hard disk

Use the program “CDAutoPlay” on the
DAIRYPLAN CD to set up “Automatic Start”

Call up Windows installation program from the
CD (see Windows manual), then the program
"CDAutoPlay”.

Replace the dual port card
Correct the addresses of the dual port cards

Switch PC off and allow to cool. Retry several
times. If it functions, save straight away on a
separate disk. Start the hard disk repair
program (e.g. CHKDSK, ScanDisk). Format hard
disk if necessary and re-install the entire PC
system. For a description see PC manual.
Preferably call in a PC expert.
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| 11.2 Computer system - DAIRYPLAN software |

Malfunction

Cause

Remedy

Animals are not appearing
on the right lists

Poorly designed report

Animal data not entered

”

Unsuitable “Follow-up vet actions

Set-up in list design (DPList) in order to see the
animals included by DAIRYPLAN.

Select a missing animal. Call up DPSingle to check
the data entry. Check all programmed data as “List
limit” and verify the ”Status code”.

A lot of reports require a “future vet action” for
the animals to be listed correctly.

Reports not printed
automatically

Automatic functions not set
Report has no animals

Set automatic functions

The report must have at least one animal within
the limit values. Try to start the list manually and
change the “Report limits”.

Milking animals are being
listed as “missing”

Animal not identified

Wrong setting in “automatic time event”.

Too short a time has been set for the time
before next “missing animals” check.

No action required. DAIRYPLAN will estimate the
data required.

Correct settings

Correct the time between the first and last milking
of animals within one milking session.

Animals are not being
milked but are not being
identified as “missing”

Another animal has been incorrectly
identified.

Wrong setting in “automatic functions”

Too much time has been set as the time
before next “missing animals” check

Animal has the wrong status code

Animal has the wrong lactation number

The group of animals has been set to the
wrong number of milking operations.

Delete the incorrect animal data
Set the automatic functions correctly

Correct the time between the first and last milking
of animals within one milking session..

s

“Dry”, “prepared” or is not being checked. Enter
correct status.

Animals with a lactation number of "0” are being
left out (unless in “SET-UP, #3.Set-up, Milking
parlour, #1.General set-up, Milking parlour” the
option “exclude animals with no lactation number
= No” has been selected). Enter the right lactation
number for the animal.

Change in “Set-up, Group, Group Parameters ” or
change “Group number” for the animal.

Lactation totals are not
correct

System still not working long enough.

““Estimation of lactation totals ” has been
started.

A full lactation is needed to obtain a proper
production data record. Estimations can be made
by

(a) entering the current estimated values from the
control association ( computer centre, etc.) or

(b) starting “estimation of the last lactation totals”
for a rough estimate of the last production.

The last production will be estimated roughly
based on the actual daily quantity of milk. It should
not be used apart from shortly after the system
starts. If it has been used inadvertently, then
current data may be confused with the estimated
values. For this reason, enter numbers from old
reports.

The milk yield of missing
animals is not being
estimated correctly.

The animal has no milk yield during
lactation.

The animal’s group has been set to the
wrong “Number of milking operations”.

Animals are not identified as missing if they do not
have a milk yield from METATRON at least once a
month.

Change group set-up or put the animal in another
group.
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|11.3  Feeding

Malfunction

Cause

Remedy

"Off” or repeated error
messages on the "feed
system interface” test
screen.

Equipment fault. Mains voltage or other
electrical faults

Check transceiver

Feed monitoring says that
animals are feeding
although actually they are
not feeding

Feed supply faulty or empty

Mechanical or electrical problem with feed
dispensing system

Wrong amount of feed programmed
Wrong feed calculation programmed

Weight of portion too small

Fill the silo
Compare feed dispensing service

See section headed “Main menu”; “Feeding”.

The automatic feed calculation facility should
not be used until the system has been running
on manual for a month.

DAIRYPLAN is not giving out the specified feed
quantities (see Section on “Starting up
DAIRYPLAN"; “Settings, Feeding”)

Feed monitoring (correct)
shows a lot of animals not
calling for food.

“"Maximum feed quantity per Interval” is set
too low

“Number of entitlement intervals” or “Intervals
per day have not been set correctly.

Insufficient access to the feed stations.

The animals are being prevented from
receiving enough food whenever they visit.

Start with the setting shown in the Section
“Start-up”; “Set-up, feed “ according to the
animals; admission to the feed stations.

If admission is light approx. 25 animals can feed
at one station for 20 hours or more per day.
Use the “Function analysis, feed dispenser ” in
“TEST” and the "FEED NOW list to check the
animals’ behaviour. Press “P” in "Test feed
system” to print a list of animals that visit the
feed station. If the animals only have
inadequate access, try modifying or moving the
feed station.
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11.4  Printer

Malfunction Cause Remedy
Printer not working - no test | No voltage Check the main fuse or switch.
printout Melted fuse Replace fuse

Faulty mains cable
Faulty printer

Replace mains cable
Have the printer serviced

Printer not printing - test
printout OK

Printer not switched on (indicator lights not
coming on)

Printer is “OffLine”

Faulty cable, loose connections or connection
made at the wrong point.

Wrong printer entered in the System Control.
PC faults

Switch printer on

Press the “online” key

Repair the cable or connections (check on the
correct connections in the PC manual).

To check, test another printer and have the PC
checked.

Printer not printing
automatically

Printer switched off

“Autom. functions” have not been
programmed into DAIRYPLAN.

Switch printer on.
See “DP Start-up DP; Minimum entry ...”

Printout is weak and
illegible

Colour tape worn.
The push-button not being pressed enough.

Replace colour tape.

Increase pressure on push-button by operating
the appropriate lever (refer to the printer
manual)
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DAIRYPLAN Error Messages
Malfunctions and Interference

| 11.5 DAIRYPLAN Error Messages
11.5.1 “Internal error number X has occurred”
This message appears if an error has occurred within the dairyplan 5 family. To
rectify the error, certain actions have to be carried out. Note the action number in
the corresponding line of your error number. The individual actions are described
in the table "”"What to do in the event of errors” at the end of this section.
In the Program column, “D” stands for a DOS program and “W"” for a Windows or
DOS program. Error messages that are marked wtih an asterisk “*” only appear in
older DP4.4 versions. “D5" indicates DOS programs which only start with version
5.0.
All Windows programs are Version 5.0/ 5.1
The “Source” and “Description” columns are to give Westfalia Landtechnik
technical personnel an idea on how to repair the fault.
No. Action | Programs Source Description
0 1 D w misc error conditions not assigned to a number
1 1 D new operator out of memory (C++ new operator)
81 9 w ADIS_Quicklmport Cannot index to record
82 9 w ADIS_Quicklmport Cannot prepare to put data
83 9 w ADIS_Quicklmport Cannot prepare subindex to put
84 9 w ADIS_Quicklmport Cannot index to sub record
85 9 w ADIS_Quicklmport Field does not allow import
86 9 w ADIS_Quicklmport Error saving Field
87 9 w ADIS_Quicklmport Error saving sub index record
88 9 w ADIS_Quicklmport Error saving index record
102 2 D loadadd: incorrect offset address for pp
103* 2 D* opencow: can’t find cowdata file
104* 2 D* opencow: data version older than program
105* 2 D* opencow: data version newer than program
106 2 D opencow: wrong number of file divisions
107 1 D checkleft: insufficient memory
115* 5 D* messup: wrong number of message pointers
116 1 D messfile: insufficient memory
117 1 D messload: insufficient memory
121 3 D loadary: lastcow pointer out of range
131 3 D cowadd: record number greater than max
132 4 D loadary: out of memory
135 4 D saveary: incorrect count from sort
141 4 D settdc: incorrect memory pointer
142 1 D gettdcin: insufficient memory
201 4 D closrep: write report form wi/ neg file
202* 6 D* openrep: incorrect report file size
203 6 D closrep: error writing report form file
204 4 D closrep: repfile value error
205 4 D closrep: error closing report form file
221* 5 D* repask: branching error
231 4 D groupld: sorted wrong number of cows
232 4 D groupset: missing zero in group rstr array
233 1 D groupset: insufficient memory
234 4 D Ihidset: sorted wrong number of cows
235 1 D Ihidset: insufficient memory
241 4 D mcrgmem: null cow structure
242 4 D mcrgmem: null cow pointer array
243 4 D mcrgmem: null sire structure / ptr array
244 4 D mcrgmem: null sorting array
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No. Action | Programs Source Description
245 4 D mcrtmem: memory reallocation error
246 4 D mcremem: memory reallocation error
247 5 D mcrgmem: non-null pointers

248 5 D mcrgmem: non-null pointers

249 5 D mcrgmem: non-null pointers

251 4 D indivrep: insufficient memory

252 4 D mcrgpadj: insufficient memory

253 1 D mcrepload: insufficient memory

261 4 D mcrsst: insufficient memory

262 4 D mcrsst: insufficient memory

263 5 D mcrsst: null pointers

271 4 D getmcrs: insufficient memory
301* 6 D* menurep: report format file not found
302* 5 D* repset: incorrect number of pointers
303 5 D spcptrs: incorrect number of pointers
304 5 D mcrepmak: dfmode out of range

305 4 D mcrepmak: mcr not compiled

306 5 D dpreport: dfmode out of range
307* 1 D* menurep: out of memory
308* 1 D* menuanal: out of memory

309 1 D dpimport: out of memory

310 5 D mlkcalc: illegal estimates attempted
351* 5 D* edtcal: incorrect number of pointers
352% 5 D* edtfed: incorrect number of pointers
353 5 D cowptrs: incorrect number of pointers
354 4 D edwfsav: cow number already exists
355 4 D edwfres: cow number mismatch

356 4 D dpf34: rec34 undefined

370 1 D edstuff: insufficient memory

371 4 D askstr: field length <= 0

372 4 D edstuff: NULL pointer to data field
373 4 D edstuff: itm out of range

374 4 D genpop: attempt to restore before save
375 4 D swpolice ram security check failed

376 4 D swpolice heap security check failed

377 4 Dw TarSet illegal time entry in table

381 1 D fastfeed: insufficient memory

382 1 D feedtabl: insufficient memory

383 1 D edcfed: insufficient memory

384 1 D mbackup: insufficient memory

385 1 D fastmth: insufficient memory

391 4 D fcv_get_data NULL structure pointer

392 1 D fcv_get_fmem insufficient memory

393 6 D fcv_get_fmem incorrect number of feeds

394 1 D feedtable insufficient memory

395 1 D fcv insufficient memory

401 1 D memsetup: cannot allocate any memory
402 1 D wwopen: insufficient memory to open window
411 4 D malint: pointer was previously defined
412 1 D malint: cannot allocate sufficient mem
413 4 D mfrint: pointer not defined

414 4 D mfrint: error freeing memory

416 4 D malrel: pointer was previously defined
417 1 D malrel: cannot allocate sufficient mem
418 4 D mfrrel: pointer not defined

419 4 D mfrrel: error freeing memory

420 4 D dumchkgr: dummy graphics check in gr mode
430 4 D swapres: item pointer error

451 1 D edbins: insufficient memory

7160-90017-521
12-2002

89



DAIRYPLAN Error Messages
Malfunctions and Interference

No. Action | Programs Source Description
452 1 D edtfed: insufficient memory

453 1 D edtmlk: insufficient memory

454 1 D edhard: insufficient memory

455 1 D edtime: insufficient memory

461 1 D grouprep: insufficient memory

472 4 D edtfedar: incorrect number of pointers
473 4 D edtmlkar: incorrect number of pointers
501+ 4 D* mlkfp: negative number of days

601 3 D cowload: read error from cow file

602 3 D cowsave: write error in cow file

603* 3 D* savecid: write error saving cowid in file
604 4 D cowload: record number range error

605 3 D cowload: seek error in cow file

606 4 D cowsave: record number range error

607 3 D cowsave: seek error in cow file

608 4 D cowsave: record number mismatch

609 1 D cowload: out of memory

610 4 D cowdisk incorrect substructure count
611 4 D cowdisk attempt to write cow, not allowed
612 4 D cowdisk function pointer NULL

613 5 D cowgsiz incorrect cow structure size

651 4 D cowgmem: null cow pointer

652 1 D cowgmem: insufficient memory for cow ptr
653 1 D cowgmem: too many cow pointers

661 4 D cowmchk: null cow pointer

662 4 D cowmchk: null cow->gen pointer

663 4 D cowmchk: safety variable error

664 4 D cowmchk: record size error

671 1 D cowrmem: pointer count error

681 4 D cowsask: null pointer

682 2 D dpmain error chaining to DPSIZE program
701* 1 D* cownotes: error allocating memory

703* 1 D* cownotes: error allocating filler memory
711* 6 D* cownotes: error reading file header

712* 6 D* cownotes: range error in file header

721* 3 D* cownotes: read error

731 6 D cownotes: error filling file

732 3 D cownotes: error writing to file

733 6 D cownotes: error writing file header

741 4 D edfmth: assignment to Null pointer

751 4 D edcamlk incorrect index array (possibly DPSIZE)
801 3 D bullload: read error from bull file

802 6 D bullsave: write error in bull file

803 4 D bullsave: file not previously opened

804 2 D bullopen: data version older than program
805 2 D bullopen: data version newer than program
806 4 D bullload: bull ptr not initialized ok

807 4 D bullsave: attempt to save past file end
808 4 D bullload: file not opened first

810 4 D bullopen: bullary pointer not null

811 1 D bullnewr: insufficient memory

812 5 D siptrs; incorrect number of pointers
901* 2 D* mbackup: unrecognized backup drive

951 4 Dw StringArray Allocation Count too high

952 4 Dw IntSet Allocation Count too high

953 4 D mcrgmem Allocation Count too high

1001 1 D setuprt: insufficient memory

1002 1 D setuprt: insufficient mem for resp array
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No. Action | Programs Source Description
1011 1 D dpscales: insufficient memory for gate/scale control
1101 4 D scanid; null pointer

1201 4 Dw vetpre; action number out of range
1202 4 D edcivet; civary NULL

1203 1 D edcalve; insufficient memory

1204 4 D vetcheck incorrect cow number in array
1301 1 D dricow; out of memory

1302 1 D breedgra out of memory

1303 1 D vetgraph out of memory

1304 1 D duegraph out of memory

1305 1 D dr1indiv out of memory

1311 1 D drigroup out of memory

1351 1 D gqprint out of memory

1352 1 D dpgraphs out of memory

1401 1 D edcamlk out of memory

1402 1 D stitpush out of memory

1403 1 D ucopdel out of memory

1404 1 D dpimport out of memory

1405 1 D dpimport out of memory

1406 1 D mcrepsav out of memory

1407 1 D mcrptop out of memory

1408 1 D fastbull out of memory

1409 1 D edfmth out of memory

1410 1 D fastgroup out of memory

1411 1 D replacemess out of memory

1412 1 D writemessfi out of memory

1413 1 D edcamlk out of memory

1414 1 D vetcheck out of memory

1415 1 D fkereplist out of memory

1416 1 D fkecow out of memory

1501 6 D dpnetfun cannot write to file DPNET.DAT
1502 7 Dw dpnetfun cannot open file DPNET.DAT
1503 7 Dw dpnetfun cannot write share-test region
1504 6 D dpnetfun cannot write to file DPNET.DAT
1505 6 Dw dpnetfun cannot write to file DPNET.DAT
1506 6 Dw dpnetfun cannot write to file DPNET.DAT
1507 6 Dw dpnetfun cannot write to file DPNET.DAT
1508 6 Dw dpnetfun cannot write to file DPNET.DAT
1509 6 Dw dpnetfun cannot write to file DPNET.DAT
1510 6 w DPNetFile UpdateRam: illegal nesting
1601 8 w DPDatafFile OpenMemoryMappedFile, physical file

error

1602 8 w DPDatafFile OpenMemoryMappedFile, mapped object
2001 4 Dw prc control system already activated
2002 4 Dw prc illegal reactivation
2003 2 Dw prc too many channels
2004 5 Dw prc channel object integrity error
2005 5 D W prc control system integrity error
2006 5 D W prc control system integrity error
2007 5 D W prc control system integrity error
2008 5 D W prc control system integrity error
2009 5 D W prc control system integrity error
2010 5 Dw prc channel object integrity error
2011 5 D W prc control system integrity error
2012 5 D W prc control system integrity error
2013 5 D W prc control system integrity error
2014 5 D W prc control system integrity error
2015 5 Dw prc peripheral object integrity error
2016 5 Dw prc peripheral object integrity error
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No. Action | Programs Source Description

2017 5 Dw prc peripheral object integrity error

2018 5 D5 w prc Conductivity table is NULL

2201 5 Dw prc side controller integrity error

2202 5 Dw prc side controller integrity error

2203 5 Dw prc side controller integrity error

2204 5 Dw prc side controller integrity error

2205 1 Dw prc Memory Check prc files

2249

2301 1 D w TarHG GroupTable::ResetPrepare memory error

2302 1 Dw TarHG GroupTable::ResetFinalize memory error

2303 1 Dw TarHG TarHerdGroupCorrectionTable::CheckForUp
date memory error

2304 1 Dw TarHG TarHerdGroupCorrectionTable::ResetPrepar
e memory error

2305 4 D W TarHG Factor table not initialized (null)

2401 1 w ADIS_Engine Memory checks, DPData and ADIS_Engine

- files
2428

What to do in the event of errors

Carry out the following procedures if dairyplan 5 has shown hte “internal error
number X has occurred” error message. See table in this section.

Action
1 No serious problem. DP5 does not have enough memory. Only enter “DP” in order to
restart dairyplan 5.
2 Installation error. Make a back-up and then install DP5 again with the latest program

diskettes.

3 Physical problem in the data files possibly caused by power supply, lightning or
vibrations. Back-up on additional floppies NOT on the diskettes currently in use since this
back-up contains the errors). Then start “DPSIZE” to retrieve as much data as possible.
You may have lost some animal information.

4 Internal dairyplan 5 error. Please note which function was started just before the error
occurred. Then return to DP5 by entering “DP”. Inform Westfalia’s service department.

5 Serious error. All you can do is to make a note of the function last started prior to the
error occurring and then inform the Westfalia service department before you restart the
program.

6 Hard disk error which “DPSIZE” cannot put right. If it is full, delete some of the files and

try again. Report the problem to Westfalia.

7 Problem in connection with the multi-tasking operation system such as Windows or a
LAN-Network operating system. Quit all programs and reboot all computers (cold or
warm start) - this includes those connected to the network. If the problem persists, delete
the "DPNET.DAT” file with the command “del dpnet.dat” in the Dairy Plan directory and
try again.(the "DPNET.DAT” is created automatically)

8 Problem with the Memory Map File. End all DAIRYPLAN programs, in the dairyplan folder
delete files with the extension “*.mmp” and then restart DP5.
9 Problem with backing up data with ADIS-Fields, e.g. with the “DPEditData”-program.

Normally it is sufficient if the Setup worksheet is changed.
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11.5.2 ADIS Engine error codes

No Source Message Text Error |
Comment
ADIS_Engine:: . Interprets XF line (except
2501 ProcessFileSection Line Status Fault comment CF)
2502 Unknown Line Status Second char unknown
2503 Unknown control record First Char unknown
2504 Record must be alphanumeric | First char not alphanumeric
2505 Invalid DIl Header Record Wrong length for DIl header
2506 Error Including File Cannot md’;;.gz file of ,IN C
Error Request without Request line without valid
2507 o L. C
definition definition
ADIS_Engine:: Data Value line without \(a{u.e line without valid
2508 ; L definition (Event number not
ProcessValueLine definition .
matching?)
2509 Status of Value line does not
match definition line status
Warning: No Index Field or Cannot import because of
2510 | + Field missing index or no
no Import Fieids importable field defined
2511 Value Line, Data record Wrong length of value line
incorrect size according to its definition
Sub Index Field cannot be
2572 Cannot add sub index imported/added, e.g. because
(unknown vet action?) it is an unknown vet action
but main index ,,cow” is valid
Main Index field (Cow, Bull,
Cannot Find Index (Cow?) - or . Meter,...) canno.t be .
2513 imported, maybe invalid
Data Set Full? .
value or data set is full
(capacity reached)
Cannot Prepare Indexes to Somethlr'wg. wrong with the
2514 composition of value and
Put Data . .
index fields
Writing Data to DP Database
2515 Cannot Save Data failed (Access denied?)
E Returning f Includ Recursive File Includes do not
2516 ADIS_Engine:: ProcessAbort fror re urnl;).gly rom Inciude return correctly to higher C
e level
. Import of Manufacturer
ADIS_Engine:: Warning: Impqr't of Specific Events (0 <
2517 2 Manufacturer Specific Events o
ProcessDefinitionRecord . Eventnumber < 6 digits) can
denied .
be denied
2518 ADIS_Engine::ProcessSearchR Invalid Search Record Invalid Search Record (,SN*
ecord for ADIS)
2519 ADIS_Engine::ProcessSortReco Invalid Sort Record Sort Record Wrong (only RFA
rd files)
ADIS_Engine:: ADIS File Wants Version xx or VerSIor] Check Failed
2520 , . (Westfalia Manufacturer C
ProcessWestfaliaRecord Higher g
Specific Command)
Processing Westfalia Record,
2521 DELNOTCH no longer
supported since DP5.0
2522 Processing Westfalia Record,
UNLINK not implemented
Processing Westfalia Record,
2523 DECIMAL no longer
supported since DP5.0
Processing Westfalia Record,
2524 DEFREC no longer supported
since DP5.0
Processing Westfalia Record,
2525 UNREC no longer supported
since DP5.0
Processing Westfalia Record,
2526 REPEAT no longer supported
since DP5.0
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Error processing Westfalia

Any other error with

2527 Record Westfalia record
2528 ADIS_Engine:: Error processing Control Flag | Unknown Option in Control
ProcessFlagRecord Record, Option xx record
Error processing Control Flag
2529 Record, Option xx=0/1 Unknown Flag Mnemonic
unknown
2530 ADIS_Engine:: Execute Records no longer
ProcessExecuteRecord supported since DP5.0
ADIS Engine- DPD#2531 Cannot create These numbers <= 9999 are
2531 —Engine:. fields with DDNumber <= needed for internal DP C
ProcessCreateField .
9999 numberings
2532 Cannot create new field Somehow the CREATE failed C
ADIS_Engine:: Master Field list contains xx Cour'wt the dlfferent W) pes of
2533 ; L7 , . o fields defined (only in C
MasterFieldListDiagnostics Fields plus yy Substitutions . .
diagnostic mode)
. same field number defined
2534 Error: Duplicate DDNumber twice (only in diagnostic C
xx mode)
Same Mnemonic defined
2535 Error: Duplicate Mnemonic yy twice (only in diagnostic C
mode)
Something wrong with field
Warning: Unknown IndexDD definitions and mapping to
2536 , C
xx for code yy codes or formulas (only in
diagnostic mode)
Something wrong with the
Warning: Unknown ParentDD | field definition and subindex
2537 . o . C
xx for code yy ordering (only in diagnostic
mode)
Something wrong in field
2538 Warning: Duplicate Sub definition with Sub-Index c
DDNumber xx field numbers (only in
diagnostic mode)
Something wrong in field
Warning: Duplicate Sub definition with Sub-Index
2539 , . , . C
Mnemonic xx field Mnemonics (only in
diagnostic mode)
Warnina: Sub reol A Substitution overwrites
2540 a'rn'/ngl. u :;}p aces another field (only in C
original xx anajor yy diagnostic mode)
. . The substitution field itself
Warning: Indirect L
2541 .2 maps to a substitution (only C
Substitution for xx L .
in diagnostic mode)
Error C. ¢ Resol The substitution does not
2542 fror- t-annot nesolve map to a valid field (only in C
Substitution for xx . .
diagnostic mode)
2543 ADIS_Engine:: GetBuffer Checksum Incorrect (only for DII)
2544 | ADIS_Engine:: CreateHeader This header'was created by Header not spec.lfled by c
Dairyplan Request file
2545 ADIS_Engine:: ErrorMessage Error reading file xx, line y May precede an error C
message
ADIS_UserWin:: Shown when user interrupts
2546 UpdateProgressDialog User Break the progress dialog
2547 DP_ADIS_Englne::ProcessWest Error attempting to delete Cannot delete the given cow C
faliaDelete cow number xx
2500 CDPDataExchangeApp::OurPr Auto Mode impossible -A option set but no input file | MessageB
ocessShellCommand without Input File given (nothing to process) ox
i . Given fiel does not exist, even | MessageB
2591 Input File does not Exist with .ads” extension added ox
. . o The input was longer than
2502 GStringArray::ToControlMax3 | CN .... DPD#2592 Additional 32KB and therefore was not

2

Lines not Shown

displayed
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11.5.3 DPNETInstall Errors (2700 - 2799)

No

Source

Message Text

Error |/
Comment

11.5.4 DPRequest Errors (2800 - 2899)

No Source Message Text
2800 CDPRequestDIg::ExportData () Internal Error DPR#2800 The request file modified for this
DPRequestDIg::ExportData (): request is stored in a temporary
TmpRequestFile Name empty file with a certain name. This
name is lost due to a
programming error. Install system
again and restart
2801 CDPRequestDIg:: Internal Error DPR#2801 The request report definition file
ExportRFARequestData () DPRequestDIg:: modified for this request is stored
ExportRFARequestData in a temporary file. This file is
():TmpRequestFile ‘%s’ empty or | empty or does not contain a valid
invalid report definition
2802 CDPRequestDIg:: Internal Error DPR#2802 Problems with DP database
ExportRFARequestData () DPRequestDIg:: connection. Shut the DPRequest
ExportRFARequestData application and start again
():ADISEngine not found
2803 | CDPRequestDIg::ExportADISReque Internal Error DPR#2803 Problems with DP database
stData CDPRequestDIg:: connection. Shut the DPRequest
ExportADISRequestData (): application and start again
ADISEngine not found
2804 | CDPRequestDIg::ExportADISReque Internal Error DPR#2804 The request ADIS file modified for
stData CDPRequestDIg::ExportADISReque this request is stored in a
stData ():temporary request file temporary file. This file is empty
%s not found or invalid or does not contain valid ADIS
request data
2805 | CDPRequestDIg::ExportADISReque Internal Error DPR#2805 No data produced by processing

stData

CDPRequestDIg::ExportADISReque
stData ():No data could be
created?

the ADIS request file. Maybe the
file is not a request?
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DPNET interface
Malfunctions and Interference

[11.6  Multi-Port Connection Set
Malfunction Cause Remedy
No data connection Incorrect settings in DPSetup | Check settings
Multi-Port card driver not Install and check driver
installed
Multi-Port card not fitted Check installation
correctly
Multi-Port card defective Replace card
Data cable not connected Check data cable
correctly
Data cable defective Replace data cable
No power supply to the CL Check plug-in power pack
transformer
CL transformer defective Replace CL transformer
No data connection to COM3 | Problem initialising Update to DAIRYPLAN
and COM4 (7162-9047-160) | DPProcessControl Version 5.018 or higher
No data connection when AVM-Fritzcard uses internal | Free COM4 (DPSetup) or use
using an AVM-Fritzcard (Win | COM4 card 7162-9047-170
98SE/NT 4.0 - 7162-9047-160) (installation in Win98 from
COMB5).
11.7 DPNET interface
Malfunction Cause Remedy
No data connection Incorrect settings in DPSetup | Check settings and adjust if
necessary
Driver for DPNET interface Install and check driver
not installed
DPNET interface not installed | Check installation
correctly
DPNET interface defective Replace interface
Data cable not connected Check data cable
correctly
Data cable defective Replace data cable
7160-9001-521
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DAIRYPLAN information

Appendix
(172 Appendix |
[12.1  DAIRYPLAN information |

Finding out the version number

The DP version number should be given in the event of any technical questions.
DAIRYPLAN

e In the DAIRYPLAN menu click on the “S” button (top left).

e Select “Help-> About DPMenu”.

e The version will be shown
Other DP programs (e.q. DPList, DPTableGraph, DPView)

e In the DAIRYPLAN menu, click on the “S” button (top left).

e Call up the corresonding program.

e Select “Help-> About the program ”.

Ending DAIRYPLAN

There are always several ways of ending a DP or Windows program.

e With “File-End” (see also section on “DAIRYPLAN programs /
DPProcessControl”).

e With the cross symbol on the menu bar. Exception: “DPProcessControl”,
because this program can only be ended with “File End”.

e To close all open DAIRYPLAN programs, click with the right mouse button on
all DAIRYPLAN programs on the status bar one after the other. From the menu
that drops down select “Close” to close the application. Exception:
“DPProcessControl”, because this can only be ended with “File End”.

e The key combination “ALT/Tab” can be used to “jump” from one Windows
application tot he next. Keep the “ALT” key pressed down and move from one
application to the next with the “Tab” key. A small window with all active
programs will be visible. Release the “Tab” key when a DAIRYPLAN program
has been selected. End the DAIRYPLAN application in one of the ways
described.

Creating a shortcut

It is sometimes useful to create a shortcut on the desktop to reports/programs that
are frequently used.

e Select file in Explorer.
e Call up the context menu with the right mouse button.

e Select the command “Send to”; “Desktop (create shortcut)”.
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Appendix

Files used by DAIRYPLAN

CDAutoPlay.exe This program enables the user to select various programs on the CD. It
is needed by the “AutoRun” program on the DAIRYPLAN CD.

DPDataTest.exe A diagnostic tool to check and repair dairyplan 5 records. It checks the
record for various types of error.

DPView.exe Shows information on the process control in real-time. The

information is only selected and written into the “DPView.Dat" file.

DPProcessControl.exe

Controls the entire communication between the peripherals and
dairyplan 5.

DPList.exe

Processes “"RFA” files to produce reports from DAIRYPLAN data. This
includes displaying the reports on the screen, printing them and
transferring the text to files.

DPTableGraph.exe

Shows all measurement value tables in graphical form

DPSingle.exe

“"DPSingle” provides “quick reference” information on an animal or
calf. This program provides the Windows view of the familiar F3 and
F4 function keys in "DPMain”.

DPEditData.exe

Data input program

DPMenue.exe

The main DAIRYPLAN menu

DPVet.exe “"DPVet” is used to enter vet actions in the DP databank. It replaces all
functions under the heading “Vet Action” in DPMain.
DPPort.exe Test program for multi-port connection and communication
ASCTOADS.exe Program to convert from ASCII format to ADS format
DPDAIRY.DAT Data file with animal data and settings
DPPERIPH.DAT Data file with “Animal monitoring data”
DPSIRES.DAT Data file with bull data
DPFEEDS.DAT Data file with feed tables for calculating feed concentrate
DPNOTES.DAT Data file with note-book information
DPID.DAT File with information on the latest update
*.DPE Form for DPEditData
DPMSG *.DPM File with the screen texts of a language
* HLP Files with help text in the directory “\HLP”
*.RFA Files with specifications for reports. These are ASCII files, which can
also be created by an external program
*.ADS Data / files in "ADIS” format
*.Dll Data / files in "DII” format
*.DPX Settings for different programs
*.ADF Ad(ditional data files for special records
DPMIKO.exe

DPKartenarten.exe

DPMikontroll.exe
Program for exchanging data with the LKV (in Germany)
DPLKV.exe
DPRegToCow.exe
DPHITTransfer.exe
DPHerdstat.exe Herd statistics program

DPScatterGraph.exe

Point charts for showing various data

DPRequest.exe

User interface for data exchange

DPEvents.exe

Program to display process control events

DPRegConverter.exe

Program for changing ear tag numbers
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Glossarylabbreviations

Appendix
[12.2  General remarks |
Problems and requirements
We will gladly provide you with further assistance. Our company address is:
Westfalia Landtechnik GmbH
Werner Habig Str. 1
Cullompton | Devon
Tel. (02522) 77 0
Customer service
If necessary, please contact your nearest authorised specialist dealer.
Advice
Up-to-date information can be found on our website at
http:/lwww.westfalia.com.
[12.3  Glossarylabbreviations |
AR AUTOROTOR rotary milking parlour
ATD AUTOTANDEM milking parlour
Tree Structure/set-up of the network
DP “DAIRYPLAN” herd management program
Desktop Windows desktop
DPNET interface Interface for the data connection between
"DAIRYPLAN" and the Westfalia peripherals
connected
DPNET equipment Network components (eg METATRON, feeding,
box/gate control units)
FGM Herringbone milking parlour
Host processor Additional processor for a DPNET device
ISO reader Identification module for animal identification
system
Neuron processor Network processor for a DPNET device
Network installation Addressing in the network
Service Pin [ Neuron ID Unique identification number (48-bit) for a DPNET
device
Peripherals DPNET components
SBS Side-By-Side milking parlour
Scanning Address check on the DPNET devices linked to the
network
Signal Command from DPNETInstall to the DPNET
device after successful installation
Wizard Help tool in DAIRYPLAN
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“DAIRYPLAN Installation Description” form
Appendix

| 12.4  “DAIRYPLAN Installation Description” form

If you report a problem to the service department, please try to supply the following information as far
as possible. This will save time and telephone charges!

DAIRYPLAN Installation Description Date:

Farm | dealer details

Farm details Dealer

Name / Address: Name / Address:
Andrew Brown / Manor Farm John Smith / Dairy Systems
Cullompton / Devon Cullompton / Devon
Grove Road
Tel.: 02522 /1234 Fax: 02522 /5678 Tel.: 02520 /1234 Fax: 02520/ 5678

Details of milking installation
Milking Installation (type, number) 2x6 FGM
METATRON (number, type / for METATRON query with 935) 12 x METATRON
Identification system - if known: Type (VC3, V4, ...) VC 4

Feed Calf feeder | TWIN Feeder | DP-Junior MK-Feed
concentrate
Feed boxes (type, number) box
2 1
Other parts controlled by DAIRYPLAN (segregation gate,
animal scales, ...)
PC Equipment Details
(information gathered from invoice or despatch note from supplier)
Processor: Miscellaneous
(tick or enter under “Miscellaneous”) X
Operating System Windows 98 | Windows2000 | Windows XP | Miscellaneous
(tick or enter under “Miscellaneous”) X
Memory (RAM, amount shown on start-up) 128MB
Networks -
Programs running simultaneously with DAIRYPLAN Word, Internet connection
Details on DAIRYPLAN:

Version number of first installation with date: DP 4.326, November 1995
last update: DP 5.020, January 2002
Number of animal data records: 120
Installed modules: P-M P-F P-S HM-D | HM-M | HM-H | HM-SR
(mark with a cross) X X X X

How long have you had the problem?
What happened at the same time? (Power cut, changes in the

’ | since power failed when lightening struck
installation...)

Description of problem (use extra sheet of paper if necessary)
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“DAIRYPLAN Installation Description” form

Appendix
DAIRYPLAN Installation Description Date:
Farm | dealer details
Farm details Dealer
Name / Address: Name / Address:
Tel.: Fax: Tel.: Fax:
Details of milking installation
Milking Installation (type, number)
METATRON (number, type / for METATRON query with 935)
Identification system - if known: Type (VC3, V4, ...)
Feed Calf feeder TWIN Feeder DP-Junior MK-Feed
concentrate
Feed boxes (type, number) box
Other parts controlled by DAIRYPLAN (segregation gate,
animal scales, ...)
PC Equipment Details
(information gathered from invoice or despatch note from supplier)
Processor: Miscellaneous
(tick or enter under “Miscellaneous”)
Operating System Windows 98 | Windows2000 | Windows XP | Miscellaneous
(tick or enter under “Miscellaneous”)
Memory (RAM, amount shown on start-up)
Networks
Programs running simultaneously with DAIRYPLAN
Details on DAIRYPLAN:
Version number of first installation with date:
last update:
Number of animal data records:
Installed modules: P-M P-F P-S HM-D | HM-M | HM-H | HM-SR
(mark with a cross)
How long have you had the problem?
What happened at the same time? (Power cut, changes in the
installation...)

Description of problem (use extra sheet of paper if necessary)
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Westfalia Landtechnik GmbH e Werner-Habig-StraBe 1 ¢ D-59302 Oelde
Tel.: +49 (0) 2522/77-0 e Fax: +49 (0) 2522/77-24 88 e Internet: http://www.westfalia.com

Production and Central Warehouse e MiihlenstraBe 17-20 e D-58313 Herdecke
Tel.: +49 (0) 2330/64-0 ® Fax: +49 (0) 2330/13866

We always reserve the right to make structural and design modifications.






